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Adobe Connect terminology:

1. An Adobe Connect meeting is a virtual synchronous gathering of people and resources in a unique online 
meeting room. 

2. An Adobe Connect Meeting room is the virtual environment in which a meeting, learning event, or webinar 
takes place.

3. A pod is an area of the screen where information is displayed, where data is transferred, or in which 
interactions take place. Pods include chat, file sharing, presentations, notes, and Q&A, among others.

4. A layout is a specific arrangement of pods. There are pre-configured layouts. Layouts may be easily 
customized.

5. Hosts, presenters, and participants are the user roles within a meeting. They are identified by the  
following icons: 

6. A host sets up the meeting, invites participants, prepares content for display and sharing, and can make 
participants into presenters or hosts.

7. A host can share his or her computer screen, share documents such as PowerPoints, broadcast live video and 
interact with participants in Q&A.

8. A participant can view the Presenter’s content, communicate with others in chat, and ask questions. When 
enabled by the host, participants can speak to the meeting, interact with content, and share screens and 
whiteboards.

Host Presenter Participant



1. Getting started
Lesson overview

Topics covered in this lesson:
•  Introduction to WebEx and Adobe Connect
•  System requirements

About this guide

This guide is designed to help you transition from a WebEx 
environment to the Adobe Connect environment. The WebEx 
method for working is described on the left-hand page, while the 
Adobe Connect process is displayed on the right-hand page.  While 
this guide should help smooth your transition, it is not intended as 
in-depth training. 
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Introduction to WebEx

WebEx meetings run on WebEx’s global network of servers as hosted accounts. There is no option for internal 
hosting on your own servers. The software is delivered to each user’s computer by the WebEx Meeting 
Manager, which must be downloaded to your PC whether you are hosting or participating in a WebEx session.

WebEx comes in several versions:

• Meeting Center—Creates online, interactive meetings for presenting information, sharing applications, and 
collaborating on projects

• Training Center—Creates structured curricula and courses for online synchronous training; includes stored 
tests, quizzes, and polling; tracks student performance

• Event Center—Manages events with comprehensive tools to handle pre- and post-event details
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Introduction to Adobe Connect

Adobe Connect is a Flash technology powered online synchronous and asynchronous content delivery and 
collaboration system, which may be licensed to your servers, hosted on Adobe Systems’ servers, or hosted by a 
managed services provider offering full control over compliance and security.

Because Adobe Connect is based on Adobe Flash technology, which is already installed on virtually all 
Internet-connected computers, participants do not need to install any software to take part in an Adobe 
Connect session. Hosts and presenters only require a seamless Adobe Connect Add-in. 

Adobe Connect is used for: 

Web Meetings—Adobe Connect for Web Meetings enables you to significantly improve collaboration, both 
inside and outside your own organization’s firewalls. You can use Adobe Connect for a full range of online 
meeting needs, from simple screen sharing all the way to mission-critical, real-time collaboration. Adobe 
Connect allows your teams to work more efficiently and effectively, and drive to better outcomes while 
reducing operating expenses.  

Key benefits of Adobe Connect for Web Meetings

• Ensure easy meeting access and intuitive experiences for all participants.

• Enable rich, highly collaborative interactions so your teams can complete work faster.

• Manage meetings and content more effectively.

• Meet your organization’s security and compliance requirements.

• Integrate with your existing systems and extend core Adobe Connect capabilities to meet specific needs.

• Optimize scalability, performance, and usage.

Webinars—Adobe Connect for Webinars enables organizations to increase attendance, boost response rates, 
and generate more interest through rich and engaging, highly interactive, and impactful online events. 

Key Benefits of Adobe Connect for Webinars

• Ensure easy webinar access and maximize attendance.

• Capture audience attention and keep participants engaged.

• Reach thousands with the Adobe Connect Webcast option.

• Utilize event management services to ensure success.

• Enable self-registration of participants.

eLearning—Adobe Connect for eLearning provides novices and experts alike with the capabilities needed to 
easily create and deliver compelling self-paced online courses, conduct highly interactive virtual classes, and 
efficiently manage training programs. 

Key benefits of Adobe Connect for eLearning

• Rapidly create high-impact training.

• Deliver engaging virtual classes and on-demand courses.

• Manage participation, track progress, and assess course effectiveness.

• Enhance training sessions by integrating Adobe Connect with third-party systems.
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System requirements

System setup for WebEx

Meeting Manager is a software program that you install on your computer, and one that you must use when 
participating in a meeting. Meeting Manager lets you share information, send messages, send and receive live 
video, take notes, and record a meeting. If you do not install Meeting Manager, your Meeting Center website 
will automatically install it for you.

System requirements

Your system must meet these requirements for installing Meeting Manager: 

PC Environment

• Operating System – XP Service Pack 3, Vista, Windows 7

• Minimum CPU Speed 1.8 gHz

• Minimum RAM 2 GB

• 	Internet Explorer 8

• 	Javascript and cookies enabled in the browser

MAC Environment

• Any current operating system

• Minimum CPU Speed 1.3 gHz

• Minimum RAM 1 GB

• Safari 4 or better

• Java 5 installed
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System requirements

System setup for the Adobe Flash Player

Any computer with Flash Player installed can participate in an Adobe Connect session. Hosts and presenters in 
Adobe Connect have added capabilities which are enabled by a lightweight plug-in: the Adobe Connect 
Add-in. The first time you’re called upon to host or present in Adobe Connect, you’ll be asked to install the 
Add-in. 

Choose “Run” when you agree to install the add-in and then follow the installer instructions on the screen. 
Your firewall software may ask if you wish to continue. Please choose ”Yes”, “Continue” or “Run” should these 
options appear. 

System requirements

Your system must meet these requirements in order for you to be a meeting participant:

• Adobe Flash Player for the browser (version 10.1 or higher)

• Minimum bandwidth requirement is DSL/Cable (wired connection recommended)

• Minimum 1 GHz processor recommended when sharing your desktop or an application

Adobe Connect Add-in executable file

Adobe Connect Add-in Install Wizard

Click Install Finished install
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2. Web meetings
Lesson overview

Topics covered in this lesson:
•  Logging into a web meeting
•  Creating a web meeting
•  Managing a web meeting
•  Recording a web meeting
•  Managing the web meeting library
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Logging into a web meeting

Logging into a WebEx meeting

1. Open a web browser.

2. Browse to the URL provided by the host, or click the URL in your meeting invitation email.

3. Enter any requested information on the Information page.

4. Click Join Now.
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Logging into a web meeting

Logging into an Adobe Connect meeting room

1. Open a web browser.

2. Browse to the URL provided by the host, or click on the URL in your web meeting invitation email.

3. Under Enter as a Guest, type your name.

4. Click Enter room.

Enter as a Guest
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Creating a web meeting

Overview of user roles in a meeting room

Each participant in an online WebEx meeting has one of the following roles: host, presenter, panelist (Training 
Center only), or attendee. These roles determine which options are available to you in the WebEx user 
interface.

• Host—WebEx works with named hosts. That is, the account is set up in the name of an individual who can 
schedule and start a meeting; control audio and video functions; control quizzes and polls during a meeting; 
and pass control of the meeting to presenters, panelists, and attendees.

• Panelist (Training Center only)—A panelist has presenter rights at the same time as a host, but cannot control 
audio or video functions or start polls or quizzes. A panelist can present slides, share his or her desktop, and 
share applications.

• Presenter—When the host passes control to an attendee in any of the WebEx environments, the attendee 
becomes a presenter. Presenters can share content, share applications, control meeting options like polling 
and quizzes, transfer files, and use live video.

• Attendee—Attendees view content displayed by presenters. Depending upon privileges set by the host, 
attendees can use the chat window to converse publicly or privately, use icons to interact with hosts and 
presenters, have their audio connection turned on so they can ask questions or make comments, and record 
the meeting if granted permission by the host. 

To Start or schedule a WebEx meeting

1. 	Log on to your Meeting Center website.

2. On the left navigation bar, click Host a Meeting.

3. Click Schedule a Meeting.

4. Click the link in the title bar to choose the type of meeting you would like to schedule.

5. On the Scheduler page, enter the specific details about your meeting.

6. Click Start Now to start your meeting.
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Note: A meeting room 
exists until you delete it. 
The duration of a meeting is 
only displayed at the time 
of the initial invitation and 
is displayed in your Connect 
dashboard. No additional 
setup is required to schedule 
additional meetings in 
existing meeting rooms.

Note: You should have 
received your login and 
password in an email from 
the Adobe Connect server 
or your Adobe Connect 
administrator.

Note: Any number of 
participants can be made 
hosts or presenters 
simultaneousy in Adobe 
Connect.

Creating a web meeting

Overview of user roles in a meeting room

Adobe Connect allows you to create online meeting rooms where your web meeting, eLearning course, or 
webinar takes place. You can reuse a meeting room and the content you place in a meeting room remains 
there until you remove it, so you can store work in progress in each room and pick up immediately where 
you left off previously. 

There are three different types of web meeting attendees:

• Host—A host sets up meetings, invites guests, approves guests, puts rooms on hold, adds/edits layouts, 
changes the status of attendees, switches modes, shows content, screen shares, broadcasts audio and 
video, and controls participant audio and video feeds.

• Presenter—A presenter shows content, screen shares, chats, answers questions, and broadcasts live 
audio and video.

• Participant—A participant views and participates in web meetings, views all content, hears and sees all 
audio and video broadcasts, and if given permission, can broadcast their own audio and video or share 
their desktop, documents, and applications.

To schedule an Adobe Connect web meeting

1. Browse to Adobe Connect Central. If you are logging in for the first time, enter your login and password 
and click the Login button.

2. From the home page, click the Meeting button next to Create New.

3. Follow the Meeting Wizard steps. Only the Name field is required.

Create New Meeting
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Managing a web meeting

Navigating within a meeting room

1. Log on to your Meeting Center, Training Center, or Event Center website.

2. Click the My WebEx tab to view your previously scheduled meetings.

3. Click Start Now to go to your meeting room.

4. Once in the meeting room, you will see panels on the side of the page. You can view participants and use the 
chat window. Other panels are available by clicking icons above the Participants list such as Video and 
Notes. The panels can be undocked, resized, and moved around the screen.

5. A menu bar across the top gives you access to features such as document, screen, whiteboard, and 
application sharing, as well as control over the options and permissions of an action, such as recording. 

6. Viewing icons at the bottom left allow you to switch all participants to full-screen mode or resize your 
display once a document such as a PowerPoint presentation has been loaded into the session.

7. In full-screen mode, a separate menu appears at the bottom right to allow access to panels such as the 
Attendee List and Chat.
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Managing a web meeting

Navigating within a meeting room

If you are an invited attendee and you are responding to an email invitation to join an Adobe Connect session, 
after clicking the email link you will be directed to a login screen where you will enter your name and then click 
Enter room.

However, if you are a host, you have several choices:

• Hosts may use the email link, select the Enter with your Login and Password radio button and then  
click Enter room.

Attendee login

Host login
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• Hosts may also go to your Adobe Connect Central site and enter your login ID and password. The resulting 
screen lists the meetings you or other hosts in your organization have created. You can start a meeting by 
clicking the Open button in the left pane or its URL in the right pane.

As an Adobe Connect host, you have menu choices at the top of the screen that participants do not see. Under 
the Layouts menu option, select Discussion and examine the pod layout.

Also under Layouts, select Collaboration and examine the pod display.

Select Sharing under the Layout menu choice and explore the pod layout.

Click the remaining menu items at the top of the screen—Meeting, Pods and Audio—and explore the 
available options.

Hosts have two icons in the menu bar—one connects the host’s audio and the second starts the host’s webcam 
and enables participants’ webcams. Experiment with each of these.
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My Meetings at Adobe Connect Central

Layouts menu

Audio and video controls



Managing access to a meeting room

If you invite attendees to a meeting when scheduling it, Meeting Center automatically sends invitation email 
messages containing information and URLs that your invitees need to join the meeting. If you would like to 
invite attendees during a meeting, you can do that either by email or SMS text messages:

• 	Email—In the Meeting window, choose the Participant tab. Click Invite. Click By Email. Now you may choose 
your own local email system or WebEx’s email service.

• SMS—If you choose SMS, a dialog box appears where you can enter the phone number of the attendee’s 
mobile device and a text message with the meeting URL. Mobile users may also connect to the audio portion 
of the program by itself.
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Note: When an attendee 
attempts to enter a blocked 
conference, the host sees a 
notification in the lower right 
corner of the screen. The 
host can accept the attendee, 
decline the attendee, or close 
the notification box. If closed, 
it will not appear again.

Note: To open access to 
a meeting on hold, click 
the Start Meeting text 
on the lower right of the 
participants On Hold 
message.

Managing access to a meeting room

In order for others to join your meeting, they need to be invited, have a meeting room URL, and have access 
to the room. In a public meeting, everyone is automatically granted access. In a private meeting, registered 
attendees must enter with a login and be approved by the host; guests may or may not be allowed 
depending on host-determined settings.

Meeting room access options are set in Step 1 of the Meeting Wizard at the Adobe Connect Central website.

Inviting attendees during a meeting:

You have the option of sending the invitations via email as previously mentioned. You can also invite 
participants during a meeting by following these steps:

1. Select Meeting.

2. Click Manage Access and Entry.

3. Click Invite Participants.

4. Click Compose Email.

17WebEx to Adobe Connect 8 Transition Guide

Manage Access & Entry

Accept/decline guest

Participants On Hold message

Attendees blocked
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Securing the meeting 

Once all required or invited attendees have joined a meeting, the host can “lock” the meeting by restricting 
access to it.

Restricting access to a meeting prevents anyone else, including invited guests who have not yet joined, from 
joining it.

To lock a meeting:

• Choose Restrict Access from the Meeting menu.

• To restore access, choose Restore Access from the Meeting menu.

Mobile support in meetings

Access to meetings from different mobile systems is available in WebEx.

Devices WebEx supports include:

• iPhone and iPad

• BlackBerry

• Galaxy (Android™ operating system)
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Securing the meeting 

Hosts can Block Incoming Attendees, Block Guest Access, or Place Participants on Hold.

Blocking incoming attendees: 

• Select Meeting > Manage Access & Entry > Block Incoming Attendees.

Blocking guess access: 

• Select Meeting > Manage Access & Entry > Block Guest Access.

Placing participants on hold: 

• Select Meeting > Manage Access & Entry > Place Participants on Hold > click OK.

Adobe Connect will display the appropriate messages for the host, presenters, and participants.

Mobile support in meetings

Mobile users may join Adobe Connect meetings. Adobe Connect works with:

• Google Android

• iPhone

• iPad 

• iTouch

• Variety of other Adobe Flash technology enabled phones
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Managing attendees

Once a meeting starts, all attendees automatically receive privileges. If the host previously specified privileges, 
then an attendee will receive those. Otherwise, all attendees receive the default privileges.

To specify attendee privileges before a meeting:

1. On the navigation bar, click Host a Meeting.

2. Click Schedule a Meeting.

3. Choose Attendee Privilege.

To grant or change privileges during a meeting:

1. From the Participant menu, choose Attendee Privileges. The Attendee Privileges dialog box appears.

2. You can assign privileges to an individual or to all attendees. Privileges are divided under two tabs: 
Communicate and Participants. To assign privileges to an individual participant, select the participant’s 
name and then choose each privilege to be assigned or unassigned. You may also select or deselect the 
Assign All Privileges checkbox. Click the Assign button to complete the process.

Attendee communication privileges are:

• Chat privately with:

• Host

• Presenter

• Other participants

• Chat publicly with everyone

The Participant tab allows privileges in the following categories:

• Document

• Save

• Print

• Annotate

• View

• Participants list

• Any document

• Thumbnails

• Any page

• Meeting

• Record a meeting

• Share documents

• Control shared applications, web browser, or desktop remotely

You may select or deselect the Assign All Privileges checkbox. Click the Assign button to complete the process.

• You may also click the Reset to Meeting Defaults button.
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Managing attendees

Once a meeting starts, all attendees automatically receive privileges. If the host previously specified 
privileges, then an attendee will receive those. Otherwise, all attendees receive the default privileges.

To specify attendee privileges before a meeting:

1. Browse to the URL for your meeting in Adobe Connect Central.

2. Click the Meetings tab.

3. Click New Meeting.

4. In Steps 2 and 3 of the Meeting Wizard, you can select participants, assign privileges, customize email 
invitations, and link the meeting to enterprise calendar systems.

Hosts, presenters, and participants can join Adobe Connect meetings from Microsoft Outlook or IBM® 

Lotus Notes email and calendar. To change privileges during a meeting:

Tip: If you want to change 
the attendee roles for 
multiple users at the same 
time, you can do this by 
holding down the Control 
key while selecting the users’ 
names. Once the desired 
users are selected, the 
rollover functions will apply 
to all of them. You can also 
drag and drop attendees 
from one role to another.

Multiple rollover selections

Add Attendees and assign roles
Send Adobe Connect Meeting Invitations
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You can use the rollover feature in the Attendee pod to manage 
attendees. 

1. Roll over the attendee’s name in the Attendee pod.

2. Choose from the following options:

• 	Start Private Chat

• 	Attendee’s name appears as a tab in the Chat pod. 

• 	Enable audio

• 	Attendee receives message he/she may now speak.

• 	Audio may be disabled with the rollover function.

• 	Enable video

• 	Participant’s webcam appears in video pod. Multiple webcams may be viewed. Video may be disabled 
with the rollover function.

• 	Request Screen share

• 	Participant receives a request to share his/her screen and then chooses to share a 
document, an application, or the desktop.

• 	Participant has a screen share option to pause, annotate, and stop screen sharing.

• 	Screen share may be revoked with the rollover function.

23WebEx to Adobe Connect 8 Transition Guide

Participant rights to speak 
pessage

Participant’s screen-share  
request message

Screen-sharing  system tray icon options

Host’s Participant Rollover Menu

Chat pod with tabs for private chat
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Managing participants

WebEx provides the presenter with an “attention indicator” (WebEx Training Center only) that looks at whether 
attendees have their keyboard focus in the Meeting window. This feature is useful in compliance training.

The Participants list can display a registration lead score and/or company name next to attendee names. This 
feature allows the presenter to give preferential treatment to certain clients if they choose to do so.

The host may highlight an attendee’s name in the Participants list in the Participants menu to:

•	 Change the attendee’s role to presenter, host, or panelist (panelist appears only in Training Center)

•	 Find a participant (useful with large groups of attendees)

•	 Expel an attendee

In WebEx Meeting Center, participants may “raise their hands” but only the participant can clear a raised hand. 
In WebEx Training Center emoticons are available and they may be cleared by the host and panelists.
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Managing participants

Managing Adobe Connect attendees with pod options

The Attendees Pod Options menu, available from the upper right Pod Options drop-down, is another way of 
managing attendee rights and privileges. 

Highlight an attendees’ name by selecting it. When you select Attendee Options from the resulting  
drop-down menu, you’ll be able to:

•	 Edit the attendee’s user info, e.g., edit the user’s name.

•	 Start a private chat, i.e., put the attendee’s name on a convenient tab at the bottom of the chat window.

•	 Enable the attendee’s audio.

•	 Enable the attendee’s video/webcam.

•	 Request that the attendee share his/her screen.

•	 Clear an individual attendee’s emoticons by selecting Clear Attendee Status.

•	 Enable the attendee to control certain pods by selecting Enhanced Participants Rights. For example, you 
might give an attendee control over the Notes pod to take meeting notes for later reference. 

•	 Remove the selected user.

•	 Clear all emoticons from the attendee pod by selecting Clear Everyone’s Status.

Attendee Pod Options Icon

Chat pod with Private Chat tab
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The Meeting menu also has attendee management functions. In addition to sending invitations and controlling 
attendee entry, the host can select Auto-Promote Participants to Presenters. This is a useful function for 
Adobe Connect sessions in which team collaboration is important.
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Emoticons selected from the drop down list appear by each attendee’s name.

Enhanced Participant Rights Checkboxes

Auto-Promote Participants to Presenters
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Recording a web meeting

Recording a web meeting

The WebEx Recorder can create a video and audio recording of your meetings, including annotations and 
mouse movements. 

To record an online meeting using WebEx Recorder:

1. Choose Recorder Settings from the Meeting menu.

2. You can choose to Record on This Computer or record on the WebEx server by choosing Record on Server.

3. 	If you click Record on This Computer you’ll be asked for a file name and location where the file should be 
saved. Files stored on the server are found under My Recorded Meetings, which is located in the left 
navigation pane of your WebEx website. URLs for recordings on the server may be emailed. Anyone who has 
downloaded and installed the WebEx Player from WebEx’s website may view and hear a recording.

4. Click Save.

5. Click Record. The Recorder Panel appears on the screen unless you have chosen to hide the panel—a 
choice found under Recorder Settings > Recorder Panel.

6. If you are using VoIP as the conference audio method, all audio will automatically be recorded. Your voice 
will be recorded through your microphone and headset. 

7. If you’re on a telephone conference, a telephone recording adapter must be connected to the audio input of 
your computer from your telephone system.

8. Pressing the Stop button on the Recorder Panel or Ctrl + Alt + P when the Recorder Panel is hidden will stop 
the recording. Ending the meeting will also stop the recording.
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Recording a web meeting

Recording a web meeting

In Adobe Connect, you can record a meeting. Anyone can view a recording if they have a URL for viewing and 
permission to view it.

To record a meeting:

1. From inside a meeting room, select Meeting.

2. 	Click Record Meeting. 

3. 	A dialog box will appear allowing you to name the recording and write a brief description. Click OK, and the 
recording will begin. 

4. 	A message window will appear in the upper right corner of your screen 
that has a Stop Recording button. This window can be closed without 
affecting the recording. As long as the red recording icon is visible in the 
upper right corner of the menu bar, the session is being recorded. 

5. 	To stop the recording, you may open the Meeting Menu and deselect the 
Record Meeting choice. 

6. 	Once a recording has been started, everything that happens visually in a 
session will be recorded.

7. 	Meeting audio is automatically captured during a recording regardless of whether 
you or your attendees are using a telephone audio conference or VoIP connection. 
Adobe Connect Universal Voice streams telephone conference audio to VoIP 
participants and to the recording itself.

Meeting menu recording choice
Recording name dialog box

Red icon and message box confirms recording

Deselect record meeting 
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Locating and editing meeting recordings

The WebEx Recording Editor can be downloaded from your WebEx home page. It is found under  
Support > Downloads > Recording and Playback page.

1. Start the Recording Editor and select File > Open and locate the recorded file, in WRF format for PCs or 
Macs.

2. In the WebEx Recording Editor, you may move a timeline bar to any point in the recording and mark it as an 
in point. Then you move the bar to a point later in the timeline and mark it as an out point. The two points 
define a segment. The Recording Editor allows you to delete a segment, copy a segment, and paste a 
segment.

3. Once editing is completed, WebEx users normally save the edited file with a different name than the original 
and store it where others may view it. WebEx allows you to create a URL that streams the content to users.

4. If, however, you send direct links to the file or forward the recorded file, viewers will have to download the 
WebEx Player to see the program.
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Locating and editing meeting recordings

After you record a meeting, it is archived in the Meetings Library associated with the meeting room.

To view and edit meeting recording information:

1. Return to Adobe Connect Central.

2. Click the Meetings tab.

3. Click the link to your meeting room.

4. Click the Recordings link.

5. Click the link for your meeting session recording.

6. Choose Edit.

7. The recorded program will begin playing. It can be paused with the Pause/Play button. To the right of the 
Pause/Play button, there’s a split triangle. 

8. Use your mouse to move the right half of the triangle to an out point. 

9. Drag the left half of the triangle to an in point. The section in between can be removed by clicking the 
Scissors icon. 

10. There’s an Undo icon that can be clicked to reverse an edit action, and there’s a Revert to Original just in 
case an editor changes his or her mind about the process.

11. Click the recording name in the left pane of the recordings page, and then select Make Offline. This will 
create a video for Adobe Flash Player on your computer’s hard drive that you can edit with a video editor 
such as Adobe Premiere Pro®.

Viewing recordings

•	 Virtually all Internet-connected computers have Adobe Flash Player installed, which is 
the only software needed to view an Adobe Connect recording.

Deselect Record Meeting Recordings can be edited online or made offline

Edit tools
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Playing meeting recordings

If the WebEx Player has been installed on your computer, you can double-click any WebEx recording (ending 
with the WRF file extension) and it will open the player and begin playing. Alternatively, you can open the 
Player, click File > Open and select the file you wish to play.

If the recording is on a website, simply click on the recording URL. The player opens automatically.

The WebEx Player console provides navigation controls that allow you to control your viewing experience.
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Playing meeting recordings

In Adobe Connect, you can play meeting archives in any web browser.

To play a meeting archive:

•  All hosts can simply click the URL located on the specific meeting recording page in Adobe Connect Central.

•  All others can view it if they are given the URL and if they have permission to view the meeting archive.

To grant permission to play a meeting archive, choose from the available options:

•  Make the meeting recording public.

•  Move the recording to the Content Library and manage permissions.

•  Make the recording offline by selecting Make Offline. This creates an FLV file which you can share on any 
website after publishing with Adobe Flash Professional.

When viewing a meeting recording, you can navigate to various points in the recording by moving the cursor in 
the play bar or by using the Index of Meeting Events.

To navigate or playback a meeting archive by the Index of Meeting Events:

1. Click the small white right-facing arrow in the middle of the left-hand border of the Connect screen.

2. A list of indexed events is displayed. Navigation may be filtered by:

• Layout changes

• Chat messages

• Slide changes

• Users joining or leaving the attendee list

• Camera pod

3. Select one of the above events.

• Playback moves to that event

• Selected event is shown in green
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Retrieving meeting recordings

Opening a meeting recording in WebEx

Any meeting that is recorded using the WebEx Recorder can be opened later. WebEx recordings stored on a 
local hard drive have a .wrf file extension. Recorded WebEx files stored on the WebEx server have an .arf file 
extension and play when double-clicked.

To open a locally stored recording, you must download the WebEx Player from the Player-Recorder page 
found under Support at your WebEx website. Once the Player is installed, open it and:

1. Click File on the toolbar.

2. Choose the recording you wish to open.

3. Click Open.

4. Click the Play button.

5. 	Navigation is available from a time-indexed play bar.
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Retrieving meeting recordings

Downloading a meeting recording

After a meeting has been recorded, it can be downloaded as an FLV file to your computer.

To choose a recording and download it:

1. Click the Make Offline link next to the recording you wish to download.

2. The download plays the whole recording and records it on your computer.

3. The recording launches in a Connect Meeting.

4. A dialog box appears. Select the Proceed with Offline Recording. 

5. The File Save box appears where you can name the recording and choose a folder in which to save it.

To search meeting archives in Adobe Connect Central:

1. From Connect Central, enter a keyword in the Search Content field.

2. 	All Adobe Connect content is searched, not just meeting archives.

3. You may filter your search choice by selecting the drop-down box under Optional Filters.

You may choose:

• All Types

• Recordings Only

You can further define your search by clicking the Titles and Descriptions button. 

The Show filter searches by:

• All

• Content

• 	Training

• 	Meeting

• Seminar

Note: The downloading 
process will take as long as 
the original meeting. You will 
be notified when the process 
is complete. 

Note: The FLV file will not 
launch by itself. You must 
embed it in the Adobe 
Media Player or other similar 
product to play your meeting 
recording. It can also be 
imported to Adobe Flash 
Professional and published as 
an SWF file.

The Field filter searches by:

• All

• Name

• Description

• Author

• Type

• Courses Only

• Presentations Only

Optional Filters drop-down menu

Optional titles in descriptions search
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Understanding the web meeting library

Understanding the Meeting Calendar:

The public Meeting Calendar on your Meeting Center website provides information about all listed meetings 
that are either scheduled or in progress.

To open a calendar view of all scheduled meetings:

1. On the left navigation pane, click My Meetings to view a list of meetings by date.

2. Click one of the following tabs: Today, Daily, Weekly, or Monthly. There are many options to view meetings 
on the calendar within each of these layouts. You may view past meetings, meetings that you host, and 
meetings you’ve been invited to, and you can search for meetings on specific dates. You may also search for 
text in meeting names.

The calendar view in WebEx:

By default, meeting lists on the Meeting Calendar are sorted by hours in ascending order. However, you can 
customize the way you sort your meetings to fit your needs.

1. Open the Meeting Calendar.

2. In a list of meetings on the Today, Daily, Weekly, or Monthly tab on the Browse Meetings page or the 
Register for a Meeting page, click the column heading by which you want to sort your meetings. You can 
sort by Time, Topic, Host, or Duration in ascending or descending order.

3. The calendar view also shows you how many people have requested permission to join meetings, how many 
requests have been accepted, and how many requests have been rejected for each meeting.

Managing the web meeting library
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Note: It isn’t necessary 
to schedule meetings for 
specific times because 
Adobe Connect rooms are 
persistent.

Understanding the web meeting library

1. Select Meetings from the menu bar at Adobe Connect Central.

2. From the Meetings page, hosts with appropriate permission can select:

• Shared Meetings

• User Meetings

• My Meetings

• Meeting Dashboard

By default, hosts can manage meetings on the My Meetings page or on the Shared Meetings page.

Administrators can manage all meetings on all pages. Anyone else can also manage and/or create 
meetings if an administrator gives them Manage permissions for a meeting page.

Managing the web meeting library

Meeting Library overview menu

Library organization chart
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The calendar view on the Adobe Connect Central home page:

It is possible to have a calendar view of all of your meetings in Adobe Connect.

The Meeting Dashboard:

You have access to the Meeting Dashboard from the main Meetings tab. It contains three graphs:

• Most Active Meetings Over Last 30 Days

• Most Participant Meetings Over Last 30 Days

• Most Viewed Recordings Over Last 30 Days

Calendar view

Adobe Connect Meeting Dashboard—Most Viewed Recordings
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Organizing and editing

My WebEx is an area on your Meeting Center website in which you can access your user account and personal 
productivity features. The following features are available, depending on the configuration of your site and user 
account:

• Personal list of meetings

• One-click meetings (optional feature)

• 	Personal meeting room (optional feature)

• 	Access anywhere (optional feature)

• File storage

• Address book located under My Contacts on the My WebEx page

• User profile located under My Profile on the My WebEx page

• Personal conference numbers (optional feature) located under My Audio on the My WebEx page

• 	Website preferences

• Usage reports (optional feature)

To view your personal list of meetings:

1. Click My WebEx on your Meeting Center website.

2. Choose Daily, Weekly, Monthly, or All Meetings to navigate through your meetings. In the drop-down 
menu, you can choose The Meetings You are Invited To or Show Past Meetings to display on your list.
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Note: Only you and 
administrators can assign 
permissions for your 
personal meeting folder.

Organizing and editing

To rename content folders:

1. Navigate to a folder.

2. 	Click the Edit Information link.

To set folder permissions:

1. Navigate to a folder.

2. Click the Set Permission link. You can view current permissions on the right side.

3. Select groups and/or users on the left side.

4. Click the Add button.

5. Select users and/or groups on the right and click Permissions.

6. Select permission: Manage or Denied.

To create new folders:

1. Navigate to any folder in which you have Manage Permissions. By default this will be your user folder or 
the shared folder.

2. Choose the New Folder button.

3. Enter a folder name. 

4. Select Save.

Additional tips on organizing meetings:

• In your personal folder, create meeting rooms that only you will use.

• Organize the majority of meetings in folders in the Shared Meetings folder (recurring meetings, meetings 
with similar content but different participants, or meetings for which you want to archive content).

• To edit meeting information, click the meeting that you want to make changes to. Then click the Edit 
Information tab or the Edit Participants tab and select one of the links to edit or manage information.
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Managing content

To manage personal folders, documents, and files:

1. 	Click My WebEx on your Meeting Center website.

2. Click My Files.

3. Click My Documents. Locate the folder in which you want to store the file(s).

4. Under Action for the folder, click the Upload button for the folder in which you want to store the file.

5. Click Browse. Select the file you want to upload.

6. Click Open.

7. Click Upload.

8. Click Finish.

To share files on your personal meeting room page:

1. Go to the My WebEx Files page.

2. Under Name, locate the folder in which you want to share files. (If the folder is closed, click to open it.)

3. 	Click the Properties icon for the folder in which you want to share files. The Edit Folder Properties page 
appears. Specify the sharing options.

4. 	Click Update.

To download files to your computer or local server:

1. Click My WebEx on your Meeting Center website.

2. Click My Files.

3. Click My Documents. Locate the file you wish to download.

4. Under Action, click the Download button.

5. Follow instructions from your web browser or operating system for downloading.
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Managing content

To manage uploaded content:

1. Navigate to a meeting folder.

2. Choose the Uploaded Content tab. This will display all items that you have uploaded into your meeting 
room. 

If you are a member of the authors group:

• You can use the same file in more than one meeting room to avoid having multiple copies on the server.

• You can move content uploaded in a meeting room to the Content Library. However, once you move it out of 
the Meetings Library, you cannot move it back.

• You are allowed to add other types of files to the Content Library besides PPT, JPG, FLV, and SWF.

• You can move meeting room content to the Content Library by selecting the specific files and clicking the 
Move to Folder link.
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Viewing meeting reports

If your user account includes the reports option, you can view the following types of reports:

• 	Usage Report—Ability to search for meetings by date or topic. Displays the meetings in date order, start time 
order, by topic, or alphabetically.

• 	Summary Usage Report—Click Display Report to view the search results. A summary containing 
information about each meeting including the topic, date, start/end time, duration, number of Attendees 
invited, number of invited Attendees who attended, and type of voice conference used will be displayed.

• Export Report—Generates a comma-delimited (CSV) version of a report for spreadsheet purposes.

• 	Session Detail Report—Click on Details in the audio column of the report to see information about the host, 
start/end times, type of audio conference, and number of Attendees. This type of report may be printed. 

• 	Access Anywhere Report—Shows information about the computers you access remotely, including the date 
and start/end times for each session.
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Viewing meeting reports

Meeting reports are available in different locations:

Reports tab—To view reports, click the Reports tab. You have access to many different reports including 
content, course, curriculum, virtual classroom, meeting, learner, system usage, and saved queries reports. 
Manager reports are also available if you choose the Manager Reports button in the upper right corner.

To run a report:

1. Choose the Meetings section from the Reports tab.

2. Choose either Meeting room Summary Report or Individual Meeting Session Report.

3. Select a meeting from the list of meetings and click Next.

4. Filter your search by choosing the appropriate user group, date, and data field. 

5. Choose Create Report. The report is displayed.

Meeting Reports—You can also view individual reports by clicking the My Meetings link.

1. Click the link for your meeting room.

2. Click the Reports tab to show reports By Summary, By Attendees, By Sessions, or By Questions.

3. Once you choose a type of report, you can download it. 

• Click the Download Report Data button.

• Get data in a comma-separated value (CSV) file.

• Data can be viewed with Microsoft Excel or other spreadsheet programs.

Individual meeting report

Reports downloading for spreadsheet analysis
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3. Webinars
Lesson overview

Topic covered in this lesson:
•  Creating and managing webinars
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Creating and managing webinars

Overview of WebEx events

Content Viewer

WebEx Event Center allows you to share documents, presentations, and applications in real time. The Event 
Center provides tools to manage pre- and post-event tasks.

To participate in an event, you must setup Event Manager software on your computer. Once you schedule, 
start, or join an event for the first time, your event service website starts the setup process automatically.
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Note: An important 
distinction is that Adobe 
Connect for webinars 
supports pre-event and 
post-event management, 
while meetings, seminars, 
presentations, courses, 
curricula, and virtual 
classrooms are the events.

Creating and managing webinars

Overview of Adobe Connect webinars

Adobe Connect for webinars enables you to: 

• Build highly interactive and dynamic web events

• Qualify prospects and develop marketing information on registrants

• Track which marketing campaigns lead to registration

• Include corporate or product logos in notifications and registration pages

• Manage marketing data with reports

• Reach thousands with the Adobe Connect Webcast option

Adobe Connect for Webinars can serve as a “wrapper” for other content. When using the Adobe Connect 
Event Management module, you can attach meetings from the Adobe Connect server to an event, you can 
build profiles of registrants, qualify prospects, and define notifications based on registration information. 
Reporting in Adobe Connect Event Management allows you to explore and filter the data resulting from an 
event.

The features of Adobe Connect for Webinars are:

• 	Registration management—You can create custom online registration forms and enable self-registration 
through attendee registration approval and confirmation.

• 	Attendee qualification—You can track registration form answers to qualify attendees and approve or 
deny attendance to events for up to 80,000 attendees.

• 	Branding—You can create and brand customer-facing webinar pages, including registration pages and 
webinar-listing pages.

• Reporting—You can track and report webinars before, during, and after they occur.

• Notification management—You can automatically send customized invitations, registration 
confirmations, approvals/denials, reminders, and post-webinar communications.

Event information page
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Performing pre-event tasks

1. Prepare content such as slides and/or documents that will be used during the presentation. 

2. Prepare your poll questionnaires before the event starts. 

3. Decide if you will use application sharing (share one or more applications at a time) or desktop sharing 
(share your entire desktop with multiple applications) during the presentation. 

4. Run through a practice session with your team (host, presenters, panelists, and polling coordinators) in order 
to make sure the event will run smoothly. Choose Start Practice Session from the Event menu. 

5. Send a reminder email to all invited participants. 

Performing in-event tasks

1. Record meetings for future playback. 

2. Synchronize all displays by clicking Sync Displays For All on the bottom of the content viewer. 

3. Stop the recorder after the event ends but before the presenter closes the Event window.

Performing post-event tasks

1. Obtain the event reports:

a. Click My WebEx on your Event Center website.

b. Click My Reports.

c. Chose the type of report you wish to generate.

d. 	Click Display Report.

2. 	Publish the event if you chose to record it:

a. Click My WebEx on your Event Center website.

b. Click My Files.

c. Choose My Event Recordings.

d. Click Add Recording to upload the event you wish to publish.

e. Click Publish.

f. Click Save.
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Performing pre-event tasks: 

1. Prepare content and upload it to the meeting room. 

2. Prepare your poll questionnaires before the webinar starts. 

3. Decide if you will use application sharing (share one or more applications at a time) or desktop sharing 
(share your entire desktop with multiple applications) during the presentation. Desktop sharing is more 
efficient but you may not want all attendees to see your desktop during the webinar. 

4. Select Meeting URL and launch. 

5. Select Invitations under Meeting to send a reminder, or copy and paste the URL and send an email. 

Performing in-event tasks

1. To activate the presenter-only area select the Enable Presenter Only Area choice from the Meeting menu. 
You can now see pods off the stage of the virtual room. This area is not visible to participants; is designed for 
presenters and hosts to work “behind the scenes” during a live session. 

2. Record meetings for future playback. 

3. 	Use the Chat Pod Options menu to create a Presenter tab to alert presenters or hosts of problems. 
Remember, once you’ve selected this tab and write in the chat window, it is only visible to presenters and 
hosts. 

4. 	Use the Q&A pod, if needed, and make sure questions are not missed. The Pods menu is where you can add 
a Q&A pod if it isn’t already present in your current layout.

5. 	If you want to reuse a customized meeting layout as a template for other webinars, move it to a Shared or 
User template folder. 

Managing post-event content and information

1. Check the Meeting Dashboard. The Meeting Dashboard shows activity over the past 30 days.

2. Make the recordings accessible:

a. Click the Meetings tab of your Adobe Connect Central home page.

b. Click the name of a meeting.

c. Click the Recordings link of the Meeting Information bar.

d. Click the check box next to the recording you wish to make accessible.

e. Move the recording to the content folder by clicking the Move to Folder button.

3. Create an on-demand Adobe Connect webinar from a recorded live webinar:

a. Create a new webinar.

b. Set the Start Time equal to the End Time for an on-demand meeting.

Move Recording to Folder
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c. Set the Presentation as Present Content from the Content Library.

d. Choose your recording as the content.

e. Use Registrant Reports and/or Attendee Reports to see who has attended the on-demand webinar.

4. View the Webinar Reports:

a. Go to the Webinar Information page.

b. Click Reports. (You will automatically see a display of the types of available reports.)  

Reports can be based on:

• Content

• A course

• A curriculum

• A virtual classroom

• A meeting

• A learner

• Saved report queries

• You can filter a report by checking off the query properties.

• You can save a report so you can run it with the same filters again.

• You can download a report to a CSV file.

5. Follow up with all attendees and those that were absent. You can choose whether to thank attendees or send 
notices when you set up email options for the webinar. Notices are automatically sent 12 hours after the webinar.

Best practices for creating webinars

1. Use folders to organize webinars logically.

• Create public and private folders.

• Use public folder webinar listings to encourage self-registration.

2. 	Use Adobe Connect for webinars to handle email notifications even if the content provides its own 
notification mechanism (in courses). If new participants are added after the webinar is published, they will 
automatically receive a confirmation email.

Filtering reports
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4. eLearning
Lesson overview

Topic covered in this lesson:
•  Creating and managing an eLearning course

Training Home Page
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Creating and managing an eLearning course

Understanding training courses

WebEx training

The WebEx Training Center enables online training to employees, customers, and partners through live and 
on-demand training sessions.

To participate in a training session, you must set up Training Manager software on your computer. Once you 
schedule, start, or join a training session for the first time, your Training Center website starts the setup process 
for Training Manager.

Using Training Center, you can set up a scheduled, instant, or audio-only training session. When setting up any 
type of training session, you can specify that it is either listed or unlisted. A listed training session appears on 
your Training Center website calendar and your Personal Meeting room page. An unlisted training session does 
not appear on any pages on your Training Center website. Attendees must provide the session number to join 
an unlisted meeting, which will help prevent unauthorized access to the training session.

The three types of training sessions are:

Scheduled—A training session that you schedule for a specific date and time. You may:

• Set recurrence patterns

• Schedule and start sessions for another user who has given you permission

• Specify voice conferencing options

• Send invitations to participants

• Require registration for participants as well as set up other security measures

• Choose privileges for Attendees

• Allow Attendees to join the session before the start time

• Choose a presentation or document to share immediately once an Attendee joins the session

	Instant—A training session that you set up and start immediately.

Audio only—A training session that is a stand-alone teleconference.
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Note: Training courses 
and curricula have three 
attendance permissions:

Enrolled: A learner whom a 
Training Manager placed in a 
course or curriculum.

Denied: A user who is 
denied access to a course or 
curriculum.

Pending Approval: A 
user awaiting approval 
from a Training Manager 
for a particular course or 
curriculum.

Creating and managing an eLearning course

Understanding training courses

The Adobe Connect for eLearning solution consists of courses, curricula, and virtual classrooms. 

In Adobe Connect, you are able to:

• Specify course start and end date

• Invite and register participants

• Send notifications and reminders

• Track student statistics

• Generate detailed reports on learners, courses, and results

• Place the course in a curriculum with other learning items

• Bring presentations into virtual classrooms and track quiz results

• Train a number of concurrent learners (the number is set by the type of license you have)

There are three main elements to Adobe Connect for eLearning:

	Courses—Contains any items from the Content Library

• Can be administered independently or as part of a curriculum or virtual classroom

• Can generate reports to track the learning progress of learners and restrict the number of attempts that 
learners have to complete the course

• Have a resume function that allows learners to view part of the course, close the course, and open it 
later in the same spot where they left off

Curricula

• A group of courses, meetings, and classrooms designed to move learners along a particular learning 
path

• Consists primarily of asynchronous courses but can include other items such as live training sessions

• Can assign prerequisites, tests, and completion requirements

• Can generate reports to track the learning progress of learners

Virtual Classrooms

• Added to curricula

• There are three access levels:

• Enrolled learners only

• 	Enrolled learners and accepted guests

• Anyone that has the URL
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Beginning your training session

Setting up a scheduled training session:

1. Log on to your Training Center website.

2. On the navigation bar, click on Host a Session to view the available links.

3. Click Schedule Training.

4. In the Session and Access Information section, enter your specific information.

5. 	In the Teleconference section, make your specific selections.

6. Go to the Date and Time section to set the date, time, duration, time zone, and occurrence pattern for your 
training session.

7. 	In the In Session Hands-On Lab section, you may select to use a hands-on lab, check the availability, and set 
up additional computers. This is completely optional.

8. Scroll down to the Registration section to specify whether attendees must register and what information 
they must provide at registration and/or choose to approve registration requests automatically.

9. 	Go to the Invite Attendees and the Invite Presenters sections. Enter the names of the attendees and 
presenters that you wish to invite to your training session. You may also enter the number of attendees and 
presenters you are inviting.

10. 	Continue to Session Options and make your selections.

11. 	Scroll down to Email Options to select the email you wish to send to participants and when you wish to 
send it.

12. On the Session Information page, you may choose to type an agenda for the session, upload a photo, or 
automatically show a document or presentation to the attendees once they join the session. You will also 
choose whether the Quick Start page will appear when attendees join the training session.

13. 	Under Course Material, you can add files for your training session.

14. Scroll to Tests. If you plan to use tests during your session, you need to make sure that registration is 
enabled. Tests may be created and saved in the Test Library.

15. Click Schedule, or click Start if you wish to start the session immediately.

Scheduling an instant training session

1. 	Log on to your Training Center website.

2. On the navigation bar, click Host a Session and then choose Instant Session.

3. Enter the specific details for your training session.

4. Click Start Session.

5. If you wish to send email invitations to your attendees, move your mouse over Invite on the participants 
panel and choose By Email. You may also invite participants by phone or by SMS text messaging. You may 
also use the Invite choice in the Participants menu.
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Beginning your training session

Scheduling a virtual classroom:

1. Start the Virtual Classroom Wizard:

• On the Adobe Connect Central home page, click Create New: Virtual Classroom.

2. On the first page of the Virtual Classroom Wizard, enter the details about your virtual classroom 
including name and brief summary.

3. Enroll your learners into your virtual classroom during the next phase of the Virtual Classroom Wizard.

4. Set up notifications and reminders (optional) to send to your enrolled learners.

To view virtual classroom information:

1. Click the Training tab.

2. Navigate to the folder that contains your virtual classroom.

3. Select the name of your virtual classroom.

Setting up an instant training session

Go to the meeting information:

1. Copy and paste URL in email or IM.

2. Accept participants.

WebEx to Adobe Connect 8 Transition Guide

Create New Virtual Classroom

Virtual Classroom URL

Note: Once created, a 
training room and any 
associated content is 
persistent and can be reused 
without any additional setup.
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Viewing training course reports

There are four types of reports:

• 	Live Training Usage Report—Detailed information about each training session and each participant from 
those sessions.

• Access Anywhere Usage Report—Detailed information about the computers that you access remotely and 
about your Access Anywhere session.

• Recorded Training Access Report—Detailed information about recorded training sessions on your Training 
Center website, including how often they are viewed.

• Registration Report —Contains registration information on any of your live sessions.

To view a report:

1. Log on to your Training Center website.

2. On the navigation bar, click My WebEx.

3. Click My Reports. Specify what type of report you wish to view, a range of dates for which you want to 
review the report, and how you want the information sorted.

4. Click Display Report.
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Viewing training course reports

There are several ways to view training reports in Adobe Connect:

1. Click the Meeting tab.

2. Navigate to the meeting or virtual classroom.

3. Click the Reports link.

4. Click Reports. You will automatically see a display of the types of available reports.  

Reports can be based on:

• Content

• A course

• A curriculum

• A virtual classroom

• A meeting

• A learner

• Saved report queries

• You can filter a report by checking off the desired query properties.

• You can save a report so you can run it with the same filters again.

• You can save, print, or download a report to a CSV file.
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5. �Web meeting, 
webinar, and 
eLearning room 
options
Lesson overview

Topics covered in this lesson:
•  Sharing presentations
•  Customizing your viewing experience
•  Using whiteboards
•  Whiteboard overlay
•  Screen sharing
•  Chat messages and questions
•  Q&A
•  Audio and video
•  Sharing files, polls, and web links
•  Breakout rooms
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Sharing presentations

How to view a presentation

The content viewer

Attendees can view shared presentations in the content viewer without the need for the applications in which 
they were created. A presenter can open a document or presentation after a meeting starts without having to 
load it beforehand.

In the Content Viewer you can share:

• 	Documents

• Whiteboards

• Your desktop

• Your web browser

• Software applications

To share a presentation:

1. From the Share menu, click Presentation.

2. Select the presentation or document you wish to share.

3. Click Open.
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Sharing presentations

How to view a presentation

The Share pod

In an Adobe Connect web meeting, webinar or eLearning session, the Share pod can be used to share several 
types of documents:

• Application files:

• 	PowerPoint (PPT and PPTX)

• 	Images (JPG)

• 	Content for Adobe Flash technology (SWF)

• 	Videos for Adobe Flash technology (FLV)

• Audio (MP3)

• PDF

• 	Zip files with acceptable content

• Whiteboards

• Your desktop

• Your web browser

• Software applications

To share a presentation:

1. Open the drop-down menu at the right of the Share My Screen 
button in the Share pod. 

2. Choose Share Document from the drop-down list, which also 
includes Share My Screen and Share Whiteboard.

3. You may choose previously uploaded content or content stored in libraries you have access to, or you may 
click the Browse My 
Computer button to search for 
a new document to present in 
the Share pod. The document 
must be in one of the 
compatible formats listed 
above.

4. Select the document and  
click Open.

Possible sources of content for sharing

Share My Screen drop-down menu in Share pod
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Presentation tools

Using content viewer tools

The vontent viewer tools allow you to perform actions and easily share presentations, documents, and 
whiteboards.

The Content Viewer annotation tools include:

• Pointer

• Text

• Line

• Rectangle

• Highlighter

• Color

• Eraser

Navigating through presentations using the toolbar:

Each presentation or document being shared appears in a tab at the top of the content viewer.

1. In the content viewer Meeting window, select the tab for the presentation or document you wish to share.

2. Click the Next tab button if there are more tabs than can appear at one time.

3. On the toolbar, click the Front Arrow or Back Arrow button to change the page or slide you are viewing. The 
Page Down and Page Up keys on your keyboard may also be used to navigate through presentations.

4. To display a specific page, click the arrow for the drop-down list. If you are sharing PowerPoint slides, you 
will also see the name of the slide in the drop-down list.

5. The PowerPoint notes icon above the Attendee List may be clicked by the presenter and notes from the 
PowerPoint slide will appear only to the presenter.



Note: The presentation tools 
are only displayed when 
content is in the Share pod.
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Presentation tools

Whiteboard and pointer tools

The whiteboard is a real-time, interactive way to share text, diagrams, and free-form drawings. It is 
available from the Share pod.

The whiteboard tools include:

• Pointer

• Text

• Line

• Rectangle

• Annotation color

• 	Eraser

• A pointer tool located at the top of the Share pod

To use a presentation pointer:

A presentation pointer is a green arrow that is used to point to items during a presentation or when 
sharing a whiteboard.

1. Click the Pointer button to display it in the pod.

2. Click somewhere in the pod.

3. Click and drag the Pointer to a new place as desired.

4. Click the Pointer button again to toggle it off.

Whiteboard tools

Whiteboard annotation samples

Pointer tool
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Advancing slides automatically

1. Select the tab for the presentation or document you wish to advance.

2. From the View menu, select Automatically Advance Pages.

3. In the resulting dialog box, choose a time interval to advance the slides.

4. Click Start. The dialog box remains on the screen, but it can be closed by clicking the X in the upper right 
corner without affecting the advancement of pages.

To stop automatic advancement of pages or slides:

1. On the View menu, select Automatically Advance Pages.

2. 	Click Stop.

Changing a participant’s view

To synchronize an attendee’s view of a page or slide:

1. 	From the View drop-down menu, click the Synchronize to All menu choice. 

Adding images

Adding text or images in the content viewer

Content stored in Clipboard memory may be added as a new page to the content viewer.

1. In the content viewer, select the tab of the presentation or document in which you wish to add an image.

2. From the Edit menu, choose Paste as New Page.

3. 	If the content viewer is displaying a whiteboard, stored images may be pasted directly onto the board 
(PC: CTRL + V, Mac: CMD + V). Stored text however, may not be pasted into a WebEx Meeting Center 
whiteboard.



Note: To load images into 
the Share pod, you use the 
same process as loading 
presentations. However, 
select a JPG file to upload 
the image. The image must 
be a JPG file.

Note: Display is synchronized 
by default.
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Advancing slides automatically

1. Select the Show Presentation Playbar from the Share Pod 
Options drop-down menu located at the top right of the Share 
pod. 

2. Click the Play/Pause button in the control bar.

3. 	Click the Play/Pause button again to stop the automatic 
advancement of slides.

Changing a participant’s view

There are two ways to change how participants view the 
presentation:

1. Make the sidebar visible by selecting the Sidebar 
icon at the bottom left of the Share pod:

• Select Show Sidebar to Participants check  
box at the bottom of the sidebar.

• Participants view only the Outline and Notes panes and they can switch back 
and forth between them.

• Participants cannot use the outline to navigate.

• 	Participants can read the slide notes.

2. Desynchronize the presentation:

• Allow participants to navigate through the presentation independently of the 
host or presenter.

• 	Click the Sync button in the Share pod or deselect SyncNavigation in the 
Share Pod Options menu.

Adding images in the Share pod

In addition to presentations, you can also load images into a Share pod. You can load images such as 
speaker photos, logos, and product photos.

1. Click the Down Arrow to the right of Share My Screen and choose Share Document.  
Then click Browse My Computer.

2. Select an image file.

3. Click Open.

Sidebar icon
Show Presentation Playbar

Show Sidebar to 
Participants
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Customizing your viewing experience

Maximizing your view

A full-screen view of pages and slides replaces the normal meeting room view. To view full screen:

1. As a participant, you can click the Full-Screen view button on the toolbar and change the view on your 
individual screen.

2. To return to a normal view, click Return to Main Window on the floating icon tray.

3. When a host clicks the full-screen icon, all participants see a full screen, but they may  
click Return to Main Window as noted above.

4. The floating icon tray allows participants to bring up undocked panels such as the Attendee List and the Chat 
panel while in the full-screen mode.
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Customizing your viewing experience

Maximizing your view

Hosts and presenters have the ability to maximize every pod within a Connect web meeting, webinar, or 
eLearning session. The maximize option is available for hosts and presenters. If a host or presenter maximizes 
a pod, participants will see the change.

In order for a participant to maximize the Share pod while viewing content:

1. Use the Full Screen button to enlarge the pod so that it takes the entire 
space within the meeting room.

2. Click the Full Screen button again to restore the pod back to its original 
size. This functionality is only available if Force Presenter View has not been selected by hosts or presenters.

When the Share pod is maximized within the application window, the size of the application window does not 
change. The participant will be viewing the meeting in a browser window. The size of the open browser 
window does not change when the host or presenter maximizes the pods.

Allowing participants to enable full screen

1. If a host or presenter deselects Force Presenter View in the Share pod option’s drop-down menu, 
participants will then have a full screen toggle option button available at the top of their Share pod.

2. Inform participants that they have control to enable Full Screen for a better viewing experience.

3. In full screen mode, participants can press Ctrl+F (PC) or Cmd+F (Mac) to see the taskbar. Press Alt+Tab (PC) 
or Cmd+Tab (Mac) to switch to other applications.

Participants Full Screen Share pod 
button
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Using whiteboards

Accessing a whiteboard

1. From the Share menu, choose Whiteboard.

2. When displaying a whiteboard, you can share it in a thumbnails view, zoomed in or out, or in full-screen 
view.

3. Clicking Standard View on the toolbar displays the whiteboard in the normal view.

4. Clicking View Thumbnails on the toolbar displays thumbnails (or miniatures) of the whiteboard content.  
Click Standard View to return to normal view.

5. Clicking the Zoom In/Out button on the toolbar and then clicking on the specific whiteboard page you wish 
to view changes the magnification.

6. Clicking Full-Screen View on the toolbar displays the whiteboard on the entire computer screen. Press ESC 
on the keyboard to return to the normal view. Participants may click the Return button on the floating menu 
bar. Hosts will have a Stop button on the floating menu bar.
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Using whiteboards

Using a whiteboard

A whiteboard is a type of Share pod with a selection of line, text, drawing, and pointer tools. A whiteboard is 
efficient if you need to quickly create a drawing or diagram during a meeting or if you want to mark up 
documents.

The operation modes are:

• One artist (host or presenter only)

• Multiple artists at the same time (all attendees or individual attendees)

The types of whiteboards include:

• A clean whiteboard with multiple pages

• Whiteboard overlay on top of content in a Share pod (like slides)

Accessing a whiteboard

Among the predefined layouts in the Layout tab, the Collaboration layout appears with a whiteboard in the top 
middle of the screen. In the Sharing and Discussion layouts, 
whiteboards can be added via the Share My Screen drop-down 
menu.

1. Click the Down Arrow to the right of the Share My Screen button 
in the Share pod. Choose Share Whiteboard.

2. You can also create a new whiteboard from the Share pod’s 
options drop-down menu at the top right of the pod. From the 
drop-down menu, choose Share and then click Whiteboard.

3. Similarly, from the Pods tab at the top of the screen, you may 
select Share and see previously created whiteboards, which may 
contain information previously posted.

Accessing a new whiteboard from the 
Share pod options drop-down
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Manipulating a whiteboard

To add multiple pages to a whiteboard:

1. In the content viewer, select the tab for the whiteboard.

2. From the Edit menu, choose Add Page.

To close a shared whiteboard:

1. In the content viewer, select the tab for the whiteboard.

2. From the File menu, choose Close.

3. If necessary, choose to save any changes on the message that appears.



Note: You may have multiple 
pages with independent 
content. Setting properties  
on one page or on one object 
does not affect properties on 
another page.
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Manipulating a whiteboard

To add multiple pages to a whiteboard:

1. Click the right-facing arrow at the bottom left of the whiteboard.

2. You can navigate to any page with the navigation arrows.

The whiteboard tools from left to right are the:

Selection tool—select any item on the whiteboard so you may change its properties.

Drawing tool–This can either be a pencil or a highlighter. When selected, a color chooser appears on the 
screen so you can select which color in which to draw. A drop-down menu also appears that allows you to 
choose the width of lines created by the drawing tool. 

• 	It is easiest to set the properties before using a tool.

Text tool—Select the text tool, click anywhere on the screen, and begin typing. Once you click the 
whiteboard with the text tool, you’ll see a font drop-down menu, a font size drop-down menu, and a color 
selector.

Rectangle tool—Select the rectangle tool, and then select the width of its borders from a drop-down 
menu, choose the fill color of the rectangle, and choose its color and opacity. Other shapes are available 
from a drop-down menu under the rectangle tool.

	You can change an object’s properties after it is created. Use the selection tool to select it and then change 
the properties from the choices at the top of the whiteboard.

Drawing tool choices

Rectangle tool

Text tools menu
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Collaborating on a whiteboard

To grant or remove Attendee privileges for sharing in the content viewer:

1. 	In the Meeting, Event, or Training window, choose Assign Privileges on the Participant menu.

2. 	In Meeting Center you may perform one of the following tasks:

• Select All Attendees.

• 	Expand All Attendees and then choose a particular Attendee.

3. Click the Participants tab.

4. Under Document, select the checkboxes of the sharing privileges you wish to grant or remove. Annotate is 
the privilege that allows a participant to collaborate on the Whiteboard.

5. Click Assign.

In the Training Center, you cannot assign specific privileges to an individual. You can assign specific privileges 
to All Attendees. Assigning Annotate privileges to all attendees allows all attendees to collaborate on the 
whiteboard.
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Collaborating on a whiteboard

Hosts and presenters can always draw on the whiteboard at the same time. As a host or presenter, you can 
enable participants to draw on the whiteboard by:

Granting an individual permission

Granting permission to everyone

To grant individual participants control of the 
whiteboard pod:

1. Click the attendee’s name in  
the Attendee List.

2. Click the Attendee List Pod Options button.

3. Click Attendee Options.

4. Click Enhanced Participant Rights.

5. In the box that appears, choose Share Pod.

6. 	Click OK.

To remove enhanced rights:

1. Click the participant’s name in the Attendee List to highlight it.

2. 	Roll your mouse over the highlighted attendee’s name to activate the rollover menu.

3. Click Revoke Screen Share.

To grant permission of the whiteboard to all participants:

1. Select the Meeting tab and click Manage Access & Entry.

2. 	In the submenu, select Auto-Promote Participants to Presenters. This process can be reversed by 
highlighting groups of individual attendee names using Shift + Down Arrow (PC) or CTRL + Click (PC). 
The rollover menu allows you to change the selected names from attendees to participants.

Watching the whiteboard:

As a host or presenter, you can use the host cursors to see who is doing what. You can make the host and 
presenter mouse cursors visible to others as they are moved around the screen. The visible host cursor 
applies to the entire screen, not just the whiteboard. The host’s and presenter’s names are displayed next 
to the mouse cursor. The mouse cursors are only visible when the mouse is being moved.

Enhanced Participant Rights menu

Pod rights options dialog

Note: An attendee with 
enhanced rights has an icon 
next to his or her name 
indicating the enhancement.
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Saving and printing a whiteboard

Saving a whiteboard

To save a whiteboard that appears in the content viewer:

1. From the File menu, select Save.

2. Select Document.

3. Choose a location to save the file.

4. Type a name for the file in the File Name box.

5. Click Save.

Printing a whiteboard

The Meeting Manager prints the content on the whiteboard.

To print a whiteboard from the content viewer:

1. In the content viewer, select the tab for the whiteboard you wish to print.

2. From the File menu, choose Print.

3. Select Document.

4. Click Print.



Note: It is important to 
remember that whiteboard 
content, like other pod 
content, remains until you 
explicitly delete it.

Note: You can stop sharing 
a whiteboard, or switch to a 
new whiteboard. The content 
on the original whiteboard 
will still be there.
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To change the status of host cursors:

By default, hosts can see one another’s cursors as they move them. To change the default setting:

1. Select the Meeting tab, then choose Preferences. Host cursor choices appear as part of General 
preferences. 

2. Choose from the available options:

• Off

• Show only to other hosts

• Show to all attendees

• Show to all attendees when using a whiteboard

Saving and printing a whiteboard

Saving a whiteboard as a PDF

If you have Adobe Acrobat® installed, you may save a whiteboard by selecting Adobe PDF as your printer 
choice.

1. From the Whiteboard Pod Options menu at the top right of the whiteboard, select Print.

2. Select Adobe PDF as your printer choice. 

3. 	Click Print.

Printing a whiteboard

With whiteboard content, you have the option to print 
individual whiteboard pages one at a time:

1. 	Navigate to the specific whiteboard page.

2. From the Whiteboard Pod Options menu,  
select Print.

3. 	Select the appropriate printer.

4. Click Print.

Print choice from Whiteboard Share Pop Options menu

Host Cursor Preferences

Selecting a printer for whiteboard content
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Whiteboard overlay

Using a whiteboard overlay

1. Open a PowerPoint file in the window for attendees.

2. Use the whiteboard tools to annotate the presentation.

Screen sharing

Understanding screen sharing

Screen sharing enables you to broadcast a real-time display of your desktop or open applications to the 
meeting participants.

You can use screen sharing to share:

• Web content

• Your web browser

• Your desktop

• A single application or window

• Multiple applications or windows

Screen sharing is commonly used to:

• Perform software demonstrations

• Watch someone perform a problem-solving technique

• Give someone remote control of your computer or ask for access to their computer
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Whiteboard overlay

Using a whiteboard overlay

You can use whiteboard tools to annotate any document in a Share pod.

To annotate a presentation, at the top of a Share pod containing a presentation, click the Draw button.

The annotation tools appear at the top left of the Share pod allowing you to draw, add text, add rectangles, and 
erase annotations.

The annotation tools remain available as you page through the slide presentation. They will remain available 
until the Draw button is clicked off.

To remove the annotation tools:

1. 	From the top of the Share pod, click the Draw button again.

2. The annotation tools and annotations are removed. However, clicking Draw again will restore any annotated 
content.

Screen sharing

Understanding screen sharing

Screen sharing enables you to broadcast a real-time display of your desktop or open applications to meeting 
room participants.

You can use screen sharing to share:

• Web content

• Your web browser

• Your desktop

• A single application or window

• Multiple applications or windows

Screen sharing is commonly used to:

• Perform software demonstrations

• Watch someone perform a problem-solving technique

• Give someone remote control of your computer or ask for access to their computer
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Sharing your desktop

To share your desktop:

1. 	From the Share menu, choose Desktop.

2. 	Your desktop will appear in a sharing window on all participants’ screens.

To stop desktop sharing:

Choose one of the following from the floating menu bar at the lower right of your screen:

1. Click Pause to freeze what your attendees are seeing from your desktop.

2. 	Click the Stop button on the floating menu bar in the lower right corner of your screen. You’ll return to the 
Meeting Manager (or Training Manager in Training Center).
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Sharing your desktop

To begin sharing your screen, you will need to use the Share pod. To begin, either:

1. Select the Down Arrow at the right of the Share My Screen button in the Share pod, or

2. Select the drop-down menu from the Pod Options icon in the upper right. 

In both cases, your choices are:

• My Screen

• Document

• Whiteboard

To share your desktop:

1. Select My Screen.

2. From the subsequent dialog box, choose Desktop to make everything running on your computer available 
to all attendees to view.

To stop sharing your desktop:

1. Select the Stop Screen Sharing option from the Adobe Connect 
system tray icon.

• This is the most efficient way to stop screen sharing.

• This action does not require you to return to the meeting room.

2. You may also select the Stop Screen Sharing option from the Share Pod Options menu.

• This option is not preferred because it exposes your meeting room to all participants if you have shared 
your desktop.

Administrators can configure a system-wide list of “authorized” applications to share while screen sharing. 
Secured desktop sharing works with Windows and Mac systems and allows users to prevent a breach before it 
occurs.

To create a secure “white list” for desktop sharing:

1. Click Administration.

2. Click Compliance and Control.

3. Click Share Settings.

4. Create the white list in the provided boxes of application processes that are authorized for sharing.

To find a process name on Windows:

1. Open the Applications menu.

2. 	Open Task Manager.

3. View the Process tab. e.g.: acrobat.exe, 
EXCEL.EXE, firefox.exe, POWERPNT.EXE.

To find a process name on Mac:

1. Open the Applications menu.

2. 	Open the Activity Monitor.

3. View process names. e.g., Acrobat, Microsoft Excel, 
Safari, Microsoft PowerPoint.

Screenshare system tray icon menu choices
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Controlling the screen share view as a participant

Attendees have limited control over how they view shared content.

To control your view:

1. At the right of the floating menu bar at the lower right of your screen, click the drop-down arrow. 

2. Click the View option.

3. Then, choose an option for viewing the shared content.



Note: When Zoom In is 
selected, scrolling happens 
automatically as presenters 
move their mouse to differ-
ent parts of their screen. 
Participants can disable it by 
selecting Scale To Fit.
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Controlling the screen share view as a participant

The Share Screen Pod Options drop-down menu allows participants to control the display to compensate 
for different screen resolutions and visual acuity.

1. Change View > Scale To Fit

• This is the default view. The presenter’s screen is scaled to fit inside the pod on the participant’s screen	
The presenter’s screen is scaled to fit inside the pod on the participant’s screen.

2. Change View > Zoom In

• “Pan and scan” mode (scrolling is necessary).

• The presenter’s screen is displayed inside the Share pod at its natural resolution.

• Content is not scaled to fit. It will be larger than the pod.

• The pod will have to be scrolled to show content on different parts of the screen.

The Full Screen toggle button at the top right of the Share Screen pod expands the Share Screen pod, 
eliminating other pods such as Chat, participant, and presenter webcam. 

 
Clicking the Full Screen button again restores the layout.

Share screen view options
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Sharing an application

Application sharing is useful for editing documents or demonstrating software. Attendees do not need to run 
the software application that is being shared on their computers.

To share an application:

1. Choose Application from the Share menu.

2. 	If the application is currently running on your computer, then select it on the list and click Share.

3. 	If the application is not currently running, click New Application. Select an application and click Share.

4. Your application will appear in a Sharing window on attendees’ screens.



Note: While you can 
share your desktop, it is a 
best practice to share one 
or more applications or 
windows instead.

Note: The Adobe Connect 
icon is added to the system 
tray (PC) or the icon bar 
(Mac).

Note: You will get a 
notification that you are 
sharing part of your screen. 
You will also get a Stop 
Sharing button in the 
upper right corner of the 
application window.
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Sharing an application

Application sharing is useful for editing documents or demonstrating software. Attendees do not need to 
run the software application that is being shared on their computers.

To share an application:

1. Click the Down Arrow to the right of Share My Screen in the middle of the Share pod.

2. Choose Share My Screen from the drop-down list.

3. Select the Applications button.

4. Choose which application you would like to share with participants. 

How application sharing differs from desktop sharing:

• Application window size matters. If the application window does not take up your full screen, it will not 
take up the entire Share pod on broadcast.

• Application focus matters. If you are sharing an application and you give focus to another application, any 
area of the shared application covered by another application will be obscured for participants.

To stop sharing an application:

1. Select the Stop Screen Sharing option from the Adobe Connect 
system tray icon menu.

2. 	Select Stop Screen Sharing from the application.

3. From the meeting room, click the Stop Sharing button in the Share 
pod.

4. Select the Stop Sharing option from the drop-down menu in the 
middle of the Screen Share pod.

To switch to another application:

Instead of stopping the screen sharing, you may switch to sharing a different application.

Do one of the following, either:

1. In the Stop Sharing drop-down menu click the Choose 
Window to Share button, or

2. Select the Choose Window to Share option from the Adobe 
Connect system tray icon menu.

Either way, the Start Screen Sharing dialog box appears.

3. Then check the box next to the application(s) you wish to 
share.

4. Click Share.

Stop Sharing

Start Screen Sharing dialog box
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Sharing multiple applications or windows

To share additional applications:

1. On the floating menu panel at the lower right of the screen, click the third icon from the left (the Select 
Content to Share icon), and it will open a menu that includes the Share Application choice. The choice is 
already checked because you’re sharing at least one application, but when you roll your mouse over the 
choice, it will list applications that are open on your computer. You can select any one of them. 

2. When any one application is being shared, all applications open on your computer will have a Share button 
next to a status tab. If the status tab says “not shared,” you can click the Share button to begin sharing the 
application. The button now reads Stop, and it can be clicked to stop sharing.

3. 	If you wish to share an application that’s not currently open on your computer, use the Select Content to 
Share icon on the floating menu bar. Roll over the Share Application choice, and from the resulting menu, 
select New Application. Select the application and click Share.

In addition to the Stop button on each application, you can use the Select Content to Share icon on the 
floating menu bar to stop sharing applications:

1. When you roll over the Share Application choice on the menu, the list of applications will appear. Shared 
applications will be selected with a checkmark. You can deselect the checkmark to stop that application’s 
sharing.

2. To stop ALL application sharing, click the Stop button on the floating menu bar.



89WebEx to Adobe Connect 8 Transition Guide

Sharing multiple applications or windows

To share multiple applications or windows, select multiple checkboxes under Applications.

When you start sharing multiple applications or windows, the focus switches from the Adobe Connect Meeting 
window to one of the applications. Each application (if possible) will get a Stop Sharing button.

To share an application: 

1. Click the Share My Screen button on the Share pod.

2. Select the Applications button.

3. Select multiple applications.

To selectively stop sharing one or more applications:

1. 	Click the Stop Sharing button at the top right of each application window you no longer wish to share.

2. 	Alternatively, click the drop-down arrow to the right of the Stop Sharing button and choose from:

• 	Pause And Annotate

• Choose Window to Share

• 	Stop Sharing this Window

• Stop Screen Sharng

• 	Help

Stop Sharing button
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Annotating your screen

As a host, you can make annotations on the applications you are sharing. If you are a participant, you can 
annotate if you have previously been granted permission by the host.

To start annotating shared software:

• Click the Annotate icon on the floating menu at the lower right of your screen. An annotation toolbar appears 
from which you may choose a pointer to draw or insert text, lines, shapes, checkmarks and “X” marks. You 
may choose the eraser tool to erase one or all annotations or pointers. Clicking the Eraser tool again turns it 
off.

To stop annotations:

• Click the either the “X” at the top right of the toolbar, or click the Annotate icon on the floating menu bar.
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Annotating your screen

If you are sharing your desktop, applications, or windows, you may choose to pause your screen sharing and 
annotate.

The following will occur if you decide to annotate your screen:

• Takes a snapshot of the screen share.

• 	Returns you to the meeting room.

• Displays the snapshot with a whiteboard overlay so you can mark it up.

To pause and annotate:

Select Pause And Annotate from the Adobe Connect system tray icon menu or the drop-down menu next to 
the Stop Sharing button at the top right of the shared application.

Adobe Connect takes a screen shot, then returns you to the meeting room with a Whiteboard Overlay on the 
image.

To leave the Pause and Annotate mode:

• Resume screen sharing—Click the Resume button at the top of the Share pod. Focus is returned to a shared 
application.

• Stop screen sharing—Click the Stop Sharing button at the top right of the application you’re sharing, or select 
Stop Sharing from the Adobe Connect system tray icon.
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Chat messages and questions

Sending chat messages

Examples of using the Chat panel:

• Attendees can have a discussion during a meeting.

• 	Send a private message to another participant.

• Send information to all participants or a specific group of participants.

• Attendees can ask a question so as not to interrupt the presenter during a meeting.

Chat messages may be sent to:

• To Everyone, excluding the host and presenter

• To Everyone

• Privately to a participant, host, or presenter

To send a chat message:

1. Open the Chat panel in the Meeting window.

2. Type a message in the Chat box.

3. In the Send drop-down list, select the recipient of the message.

4. Click Send.

Saving chat messages

You can save chat messages that appear in the Chat panel as a TXT file.

To save new chat messages:

1. Click on the File menu in the Meeting window.

2. Click Save.

3. Click Chat.

4. Specify a location to save the file.

5. 	Type a name for the file.

6. Click Save.
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Chat messages and questions

Sending chat messages

Examples of using the Chat pod:

• Attendees can have a discussion during a meeting.

• Attendees can ask questions of a subject expert so as not to interrupt a meeting.

• Attendees can ask the presenter questions during a one-to-many presentation.

Chat messages may be sent:

• To hosts and presenters

• To everyone

• Privately to a participant, host, or presenter

To send a message from the Chat pod:

1. 	Type your message in the blank text box.

2. Press the Down Arrow and choose whom you want to send the message to.

3. Choose one of the following:

• 	Press the Send button (lower right corner)

• Press the Return/Enter key on your keyboard.

Saving chat messages

As a host, you can email the chat history to yourself. To do so:

1. Select the Pod Options button in the Chat pod.

2. Select Email Chat History. The chat history will automatically be emailed to your email address.

Email choice on Chat Pod Options menu
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The Q&A panel

Understanding the Q&A panel

WebEx Training Center has a separate Q&A panel available for hosts and panelists to present to all participants. 
It is activated by clicking on the Question Mark icon at the top right of the WebEx interface. 

Questions typed into the panel by participants are time stamped. Questions may be answered by panelists 
directly in the panel or by audio commentary.

In other WebEx interfaces such as Meeting Center, the Chat panel may serve as a Q&A forum.

The Chat Viewer displays chat messages exchanged between participants:

• You can send and receive chat messages to and from meeting participants. All chat messages that you send 
or receive appear on the Chat panel in the Meeting window.

Chat is useful if you want to:

1. Communicate with other participants during a meeting that does not include an audio conference

2. Send a private message to another participant

3. Send brief information to all participants or a specific group of participants

4. Ask a question but do not want to interrupt the presenter

To answer a question in the Q&A panel:

1. Select the question by clicking on it with your mouse. The question you have selected appears highlighted.

2. Type an answer in the box and click Send.

3. Your answer appears below the question in the Communications Viewer.

To answer a question privately:

1. Select the question by clicking on it with your mouse. The question you have selected appears highlighted.

2. Click the Send Privately button.

3. 	Type an answer in the box above the Send button.

4. Click Send.
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Understanding the Q&A pod

Adobe Connect hosts and presenters can open a Q&A pod that enables attendees to pose questions outside 
the chat window. 

1. Under the Pods tab, select Q&A. The Q&A pod will appear to all, and hosts and presenters may resize 
and/or move the pod to any location on the screen. 

2. Participants may enter questions.

3. By clicking on the question, hosts or presenters can assign those questions to specific hosts or presenters to 
be answered.

4. Send the answer by choosing one of the following icons on the right side of the Q&A pod:

• To everyone

• To the person who submitted the question

To assign questions to specific hosts or presenters:

1. Select a question.

2. Select a Host or Presenter in the Assign To drop-down menu.

Q&A pod options allow a host or presenter to:

• Show the submitter’s name next to a question

• Show the presenter’s name next to an answer

• Export the Q&A pod contents as an RTF file or as an email

The Q&A pod

Assigning questions to others in the 
Q&A pod



Selecting and answering questions

The presenter can assign high, medium, or low priorities to questions. This makes it easier for moderators to 
read questions that the speaker wants to answer during a presentation.

From the Q&A Panel, the presenter can:

• Assign priorities

• Assign who is to answer each question

• Mark questions to indicate which ones were answered
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Selecting and answering questions

The presenter can select and answer questions specifically.

The presenter should:

1. Select a question in the Q&A pod.

2. Write an answer in the text field at the bottom.

3. Choose to send the answer to everyone or just to the person who submitted it by choosing the Send 
Privately icon or the Send to Everyone icon on the right side of the Q&A pod.

To manage the questions:

1. Click the drop-down menu in the top right corner of the Q&A pod.

2. 	From this menu, you can choose to:

• Show all questions

• Show only your questions

• 	Show open questions

• Show answered questions

• Export the Q&A log as either an RTF file or email

3. 	When a host or presenter clicks on a question, they can assign it to another person to answer, or they 
may delete it. This is a useful function if the question lacks relevance.

Note: A host or presenter 
can choose to answer the 
individual who submitted 
the question or respond to 
everyone.

Note: A host or presenter 
can assign questions for 
others to answer.



Audio and video

Using audio

In WebEx meetings, events, and training sessions, presenters or hosts can broadcast audio.

Options for talking to participants:

• Audio only

• Essentially a teleconference.

• Can send invitations to attendees.

• To schedule an audio-only meeting:

• On your Meeting Center website, click Host a Meeting. 

• Click Audio Only. Enter details. 

• Click Schedule Meeting.

• Phone-only option for participants.

• Mobile users can listen to the audio portion of a meeting on their cell phone by clicking on the link sent by 
the host via text message (SMS).

• Provides on-screen identity of phone-only participants.

• Teleconferencing

• Used for many-to-many meetings.

• All attendees have the ability to talk.

• No microphones, headsets, or tuning required.

• Voice Over IP (VoIP)

• Ideal for one-to-many meetings.

• Can be used for many-to-many meetings.

• Mixed-mode audio

• Uses standard phone plus VoIP in the same session.
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Audio and video

99WebEx to Adobe Connect 8 Transition Guide

Using audio

In Adobe Connect web meetings, webinars, and eLearning sessions, presenters or hosts can broadcast audio. 
In addition, you can test sound output, select a microphone, tune the microphone, and tune the silence level.

Options for communicating and recording:

Universal Voice

• Streams audio from both telephone conferences and VoIP to recordings.

• Allows telephone conference attendees and VoIP attendees to communicate with one another.

• Combines telephone conference and VoIP audio for broadcast to all listeners.

Advanced audio integration with Adobe Connect integrated telephone conferencing partners

• 	Used for small and many-to-many meetings.

• All attendees have the ability to talk.

• No microphones, headsets, or tuning required.

• Icons next to the attendee’s name indicate audio and connection status.

• Audio follows attendees into breakout rooms.

Voice Over IP (VoIP):

• Ideal for one-to-many meetings where only the host or presenter talks.

• Can be used for many-to-many meetings.



Using teleconferencing

You have several options when it comes to using teleconferencing during a meeting, event, or training session. 
You can set up a personal teleconference account, request a teleconferencing number for you and your 
attendees to use, or use the teleconferencing service of your choice.

WebEx Teleconferencing Service—You can choose to have the attendees call in or for the attendees to 
receive a call back from the teleconferencing service.

Personal Conference Number—Available only if your user account includes the Personal Conference Number 
option. Select this option to use your Personal Conference Number (PCN) account for the teleconference. With 
a PCN account, you can use the same conferencing numbers for all your meetings and set the access codes that 
you want to use to start the teleconference and the access codes that you want attendees to use to join the 
teleconference.

Other Teleconferencing Service—Select this option if you want to use another teleconferencing service 
provider or an internal teleconferencing service.
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Telephone conferencing

To enable telephone conferences:

1. Log into Adobe Connect Central.

2. Click My Profile at the upper right of the screen.

3. Click My Audio Profiles.

4. Click New Profile.

5. Select  a phone conferencing company that an administrator has made available to you.

6. Enter a Profile Name.

7. Click Save.

8. Create a new meeting or update an existing one.

9. Click Edit Information.

10. 	Select Include This Audio Conference with This Meeting under Audio Conference Setting, and select the 
profile you created earlier.

11. 	Alternatively, you may click Include Other Audio Conference with This Meeting and type the call-in 
number and passcodes.
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Audio profile dialog box

Audio Conference Settings on Meeting Information page



Using VoIP

You can use integrated VoIP in addition to, or instead of, a teleconference. Like with teleconferencing, your 
user role determines your level of participation. The use of VoIP was determined when the meeting was 
scheduled. 

As a host, you can:

• Set conference options by clicking the Audio tab and choosing Integrated VoIP and then End Conference, 
Volume, or Options. Follow directions in the message box to specify your settings.

• Allow a participant to speak by clicking on the Participants panel, choosing the name of the participant you 
want to speak, and clicking Pass Mic.

• Mute or unmute participant microphones by clicking on the Participants panel, choosing the name of the 
participant you would like to mute or unmute, and clicking Mute or Unmute.

• Mute or unmute your microphone by clicking on the Participants panel, choosing your name and clicking 
Mute or Unmute.

As a participant, you can:

• Join or leave a conference by clicking on the Communicate menu, choosing Integrated VoIP, and clicking 
either Join Conference or Leave Conference.

• Mute or unmute your microphone by clicking on the Participants panel, choosing your name, and clicking 
Mute or Unmute.

• Ask to speak during the presentation by clicking on the Participants panel and choosing either the Raise 
Hand or Lower Hand icon.

If you are a current speaker in an Integrated VoIP conference, the method by which you speak depends on the 
speaker setup option that is currently selected for your integrated VoIP session. Before you join the meeting, 
you can use the Audio Setup Wizard to select your speaker/headset and microphone settings. 
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Using VoIP

If you choose Do Not Include Any Audio Conference with This Meeting in the Meeting Wizard, VoIP will be 
the only audio source available.

There are several options when broadcasting audio using VoIP:

• A single speaker

• Multiple speakers simultaneously

• Multiple speakers taking turns one at a time

• Turn voice off

• Allow or disable participant broadcast

Host Audio Controls:

	Microphone Icon menu

• Connect my audio

• Disconnect my audio

• Mute My Mic

Once a host’s audio is connected and his or her microphone is enabled, all attendees on a VoIP conference will 
hear the host. 

To use the Audio Setup Wizard to set up your microphone and headset:

1. Select the Meeting menu.

2. Click Audio Setup Wizard.

There are four steps in the Audio Setup Wizard:

1. Test sound output.

2. Select microphone.

3. Test microphone.

4. Tune silence level.

To broadcast audio from a meeting:

• A host may choose Enable Single Speaker mode or Enable Participant’s Audio from the host’s audio 
menu.

• Individual attendees, including hosts and participants, may now selectively connect their audio and open 
or mute their microphones via the Microphone icon at the top of the screen.
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The Host’s Audio Menu



Broadcasting presenter video

A presenter’s video is broadcasted through the Video panel.

There are a few options for broadcasting video:

• Presenter-only broadcast

• Multiple video broadcasts (limit 6)

• Turn video off

There are three operation modes for broadcasting video:

• On: The live video is running.

• Pause Video: Attendees can pause their live video during a meeting by pressing the Pause button.

• Stop Video: Presenters can stop their live video at any point in a meeting.

You must connect a webcam to your computer to broadcast live video. You can connect the webcam before or 
during a meeting. The Meeting Manager will automatically detect your webcam. Generally, the Meeting 
Manager is compatible with any webcam that connects to your computer.

To broadcast video from the Meeting window:

1. Open the Video panel.

2. Click Send Video.

To stop video broadcast:

1. Open the Video panel.

2. Click Stop Video.

To close the Video panel:

1. Click the Down Arrow located to the right of the panel icons at the top right of the screen. Select Manage 
Panels. 

2. In the resulting left/right panels, you’ll see the active panels on the right and the inactive panels on the left. 
Click the Video Panel to highlight, and then click the Remove button.

You can view live video in a floating window, which you can place anywhere on your screen. It allows you to 
view video during a meeting, even when you are not viewing the Video panel.

To view live video in a floating window:

1. Open the Video panel.

2. 	Select the Undock button. Undock is only active if the number of video displays is limited to one.
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Broadcasting host or presenter video

Presenter video is broadcast using the Video pod.

Host, presenters, or participants with enabled video rights may click Start My Webcam:

• A preview appears.

• From the Pod Options menu, you can choose a different camera or video source.

• You can choose to Share My Webcam.

You must have your camera(s)connected before you enter the meeting room.

To stop a video broadcast:

1. Click the Pause icon at the lower right of the Video pod to send only a frozen image from the webcam.

2. Click the Stop My Webcam button to stop sending a video broadcast (button at top of Video pod).

From the Video Pod Options menu:

1. Start My Webcam—Camera is turned on but is not yet broadcasting.

2. Start Sharing—Broadcasts your webcam.

From the Video Pod Options menu, you can choose:

1. Select Camera—Choose a camera from those connected to your computer.

2. Start Sharing—Available if you’ve started the camera from the button on the Video pod.

3. Stop My Webcam

4. Preferences—Allows hosts to set video resolution based on bandwidth capabilities.

From the Video icon at the top of the screen you can choose:

1. Start My Webcam

2. Enable Participants Webcams

3. Start Sharing

4. Preferences—Allows hosts to set video resolution based on bandwidth capabilities.
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Note: All participants can 
pause any video broadcast 
on their own computer by 
clicking the Pause icon in 
the lower right corner of 
their Video pod. It reduces 
individual bandwidth loads. 
A still camera image is 
displayed when a viewer 
stops receiving the video 
feed.

Note: If you have more than 
one meeting room open, the 
camera will work only in one 
of the rooms.

Note: Adobe Connect 
enables users to view an 
unlimited number of video 
broadcasts during a meeting.



Video options

You can specify certain options when sending a live video broadcast from the Meeting window. On the Video 
panel, click the Tool icon to Set Video Options. 

From the Session Options tab, you can choose:

• Bandwidth—How much of the data stream your video will occupy

From the Personal Options tab, you can choose from the following:

• Video Frame Rate—How “fast” images appear to participants.

• 	Video Resolution—Higher resolution uses more bandwidth.

• Capture Device—Choose a certain camera or video source if multiple cameras are attached to your 
computer.

Selecting Advanced Options lets you manage technical settings for your video source.

In addition, you can specify other video options during a meeting such as:

• Turning the video option on or off

• Choosing single-point or multipoint video

To set these options:

1. Open the Session tab.

2. Open the Communications tab.

3. 	Choose Session Options.

4. 	Select your options.

5. Click OK.

Viewing multiple videos

You have the ability to view up to 6 video images at one time on the Video panel.

To select participants for multipoint video:

1. Make sure the video option for the video is set to multipoint.

2. Display the Video panel.

3. Click the icon for the number of videos you wish to display. (up to six at one time)

4. In the drop-down list below each video image, select a Participant.

5. Ask the participant to click Send Video on his or her Video panel.

To stop video broadcast of multipoint videos:

1. On the Video panel or floating window, click Stop Video.

2. Each participant stops his or her own video.
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Broadcasting multiple videos

You have the ability to view multiple videos in an Adobe Connect meeting. When displaying multiple videos, 
you may want a larger Video pod. 

Adobe Connect does not have any limit to the number of cameras it can display. You have the option to:

• Use other pre-built layouts—Click the Layouts button in the navigation bar and choose one of the available 
options. The Analysis layout is a good choice when you are streaming multiple videos.

• Change the pod sizes and/or create new layouts—Click the Layouts button in the navigation bar and 
choose the appropriate option.

To end the broadcast of multiple videos:

• Everyone can end their own broadcast.

• Click the Stop My Webcam button at the top of the Video pod.

• Any presenter can end anyone else’s broadcast.

• The presenter can place his or her mouse cursor anywhere on the Video pod and click the “X” that appears 
in the upper right corner of the video display.

• 	Any host or presenter can end all broadcasts by placing a mouse cursor on the video to be stopped and 
clicking the resulting “X”.

• A host can disable a participant’s video from the Video icon menu at the top of the screen or from the 
rollover menu in the Attendee pod.
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Sharing files, polls, and web links

Sharing files

Hosts or presenters can publish files that reside on their computers during a meeting. Meeting attendees can 
download these files to their local servers or their individual computers.

To publish files during a meeting:

1. In the Session window, click the File menu.

2. Choose Transfer.

3. Click Share File.

4. Select the file that you wish to publish.

5. Click Open. The file appears in the File Transfer window.

To stop publishing during a meeting:

• 	In the title bar of the File Transfer window, click the “X” to close the window. The File Transfer window closes 
in each attendee’s Session window.

The File Transfer dialog box automatically appears in your Meeting window when the host or presenter 
publishes a file.

To download the files during a meeting:

1. In the File Transfer window, select the file that you want to download.

2. Click Download.

3. Choose a location to save the file.

4. Click Save.

5. Click the Close button.
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Sharing files, polls, and web links
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Sharing files

In Adobe Connect, you can use the File Share pod to distribute files to participants from the meeting room. 
To load files, you need the Adobe Connect Add-in, which enables host and presenter functions.

If a file share pod isn’t already part of your layout you can add one by choosing:

Select Pods > File Share > Add New File Share

To add files to a File Share pod:

1. Navigate to a File Share pod.

2. Click the Upload File button at the bottom of the Share 
pod.

3. You can upload any file type from your computer or 
select a file from the Content Library. After you upload 
files to the File Share pod in a meeting room, those 
files are associated with your meeting in the Meetings 
Library.

Downloading files from a File Share pod

Once a file has been uploaded to a File Share pod, a Save To My Computer button appears at the bottom 
of the pod. Attendees can click it and save the file to a location on their hard drives.

Note: Meeting participants 
cannot upload files. If the 
host wants a participant 
to upload a file, they must 
change the person’s role to 
host or presenter or assign 
them enhanced participants 
rights for this pod.

Note: Hosts and presenters 
can upload files from their 
computers or from the 
Content Library.Pod menu: Adding a new File Share pod

File Share pod



110 WebEx to Adobe Connect 8 Transition Guide



Presenting and collaborating on PDF files

Users are able to present and collaborate on PDF files in the meeting using the Share pod. Presenters and hosts 
can synchronize the navigation as well as use the whiteboard overlay. The PDF documents are available to 
share from the desktop or the Adobe Connect Content Library in the same way as all other supported file types 
including PPT, SWF, FLV, MP3, JPG, etc.

If presenters and hosts choose to operate in a non-sync mode, then 
participants can download a shared PDF directly from the Meeting 
window by selecting the Share pod option menu at the upper right of 
the participant’s Share pod view, and selecting Save As. A new 
window appears on the user’s computer, allowing the user to select a 
download location.

There are two ways to desynchronize:

1. Click the Sync button at the bottom right of the Share pod, or

2. Deselect the Sync Navigation choice in the Share Pod Options menu. This option is selected by default.

Using the Share pod to present PDF files is more efficient than screen sharing.

Benefits include:

• Better and higher fidelity viewing experience for participants

• Lower bandwidth requirement for presenters as well as participants

• Easier presentation in case of multiple presenters

• Documents can be preloaded and organized in the meeting room

• Easier to collaborate and annotate using the whiteboard

All PDF Viewer events are preserved when a meeting is recorded.
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Attendee’s download message for Share pod PDF files.



Sharing polls

Features of WebEx polls:

• An interactive way to gather, view, and track attendee feedback from within a meeting room.

• A poll questionnaire is used to ask attendees questions.

• Can add multiple questions to each poll, but cannot have multiple Polling panels.

• Can display a timer during polling.

To create and open a poll questionnaire:

1. Open the Polling panel.

2. In the Question section, select the type of question you wish to ask—Multiple Choice or Short Answer. 
Check Record Individual Responses if you’d like a record of users’ answers.

3. Click New.

4. Type a question in the box that appears.

5. In the Answer section, click Add.

6. Type an answer in the box that appears.

7. If you wish to type another answer, click Add.

8. The questions and answers will appear in the Poll Questions area.

9. Click Open Poll in the Polling panel.

Polls can be created in advance and opened from the File Open icon at the top of the Polling panel.
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Sharing polls

Features of Adobe Connect polls:

• Polls are a real-time, interactive way to gather, view, and track attendee feedback from within a meeting 
room.

• A Poll pod can be used to ask attendees a question.

• It is important to create only one question per poll because it will affect Adobe Connect object tracking.

• You can have multiple polls.

• You should set up the poll before you start the meeting.

To create and open a poll question:

1. Navigate to a Poll pod by selecting either an existing poll or a 
new Poll pod from the Pod menu.

2. The Prepare button is selected by default.

3. Select the question type.

4. Enter the question and answers. When you are preparing a 
poll, nothing is broadcast to participants.

5. Click Open Poll. When you open the poll, the question is 
broadcast to all attendees.

6. By selecting Broadcast Results Participants will be able to 
view the percentages in the responses.
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Pod menu: Selecting a poll or adding a new one

An open poll awaiting attendee responses

Presenter’s view of a poll



To close and save poll results:

1. Click Close Poll when you are ready. You must first close a poll before you can share or view the poll results.

2. From the File menu, choose Save.

3. You can separately save Poll Results and Poll Questions.

4. Choose a location to save the results.

5. Type a name for the file.

6. Click Save.

Poll results can also be saved by clicking the Save icon in the Poll panel.

To view poll results:

1. Double-click the saved file.

2. The file will open in your default text editor.

3. For each question, the poll results show the number and percentage of attendees who chose each answer 
and the total number of attendees in the meeting.
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To close and save poll data:

• Click the Close Poll button at the top of the Poll pod.

Using multiple polls:

When creating multiple poll questions, you must create multiple Poll pods. Each Poll pod can have only one 
associated question.

If you are using multiple pods, you have two options:

1. Have multiple pod polls displayed at once.

2. 	Have one single Poll pod and switch the poll displayed in it.

• Choose Select Poll from the Poll Pod Options menu.

• All Poll pods, are displayed and the visible ones have a checkmark next to them.

• Select the desired Poll pod.

• You can have as many polls open as you want, but you must close the poll for the data to be saved.

To name a poll:

When you create a new Poll pod, it is given a default name:

• 	Poll 1

• Poll 2

• Poll 3, etc.

To rename a Poll pod:

1. Double-click the name of the pod and edit accordingly, or

2. From the Pod menu at the top of the screen choose Manage Pods.

3. Click Rename.

To view poll results:

1. Navigate to your meeting room in Adobe 
Connect Central.

2. Click Reports.

3. Click By Questions.

To view the results by answers, click View Answer Distribution next to the question.

To view the results by users, click View User Responses next to the question.
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Poll results at Meetings > Reports > By Questions

Poll reports by answer distribution or user response



Sharing web pages

A presenter can share web pages with all attendees through web browser sharing.

To share a web browser:

1. On the Share menu, choose Web Browser. Your default web browser opens.

2. Go to the web page you wish to share by typing in the web address in the address bar.

You can also share web content with attendees. However, unlike web browser sharing, this feature does not 
allow the presenter to guide participants to other web pages.

To share web content:

1. On the Share menu, choose Web Content in Page.

2. In the Address box, enter the URL for the web content you wish to share.

3. In the Type box, select the type of web content you would like to share.

4. Click OK.

To stop sharing a web browser:

1. On the title bar of the browser that you are sharing, click the Stop button at the top right of the browser 
display.

2. To stop sharing web content in a page, click File and Close.
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Sharing web pages

Using the Web Links pod, hosts and presenters can force automatic browsing of web pages on attendee 
computers.

Important benefits of using the Web Links pod:

• Allows attendees to browse websites without typing the URL themselves

• Saves time and avoids mistakes

To create a new Web Links pod:

1. Click Pods.

2. Choose Web Links.

3. Click New Web Links Pod.

To add a web page to the Web Links pod:

1. Select Add Link from the Pod Options menu.

2. Enter the URL path and assign it a name.

3. Click OK.

To open a web page:

1. Highlight the name of the web page by clicking it in the Web Links pod. 

2. Click Browse To in the Web Links pod.

3. The web page will open in a new browser window, and the active link will also be displayed in the Web Links 
pod on the participant’s computer.

Once the link is pushed, participants have full control over the window. Use screen sharing if you wish to share 
a web browsing experience.

To remove, add, or modify links:

1. Click the Web Links Pod Options button.

2. You may choose Add Link, Rename Selected Link, or Remove Selected.
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Web Links Pod Options menu

Modifying Web Links pod content



Breakout rooms

Breakout sessions

Breakout sessions allow you to brainstorm and collaborate in small private groups away from the main training 
session.

Features of the Breakout room:

1. Participants can share information, chat, annotate, and communicate via teleconference or VoIP.

2. In the main training session, information from breakout sessions can be shared with everyone.

Creating a Breakout session:

1. On the Breakout sessions panel, click Create Session.

2. Click Breakout Assignment.

3. Type a topic title in the Topic box.

4. 	To place participants in a breakout room, highlight the participant’s name, and click the Add button. 
Participants can also be added automatically by selecting the automatic assignment checkbox.

5. Click Start on the Breakout session panel. The Breakout session starts.
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Breakout rooms

119WebEx to Adobe Connect 8 Transition Guide

Breakout rooms

In an Adobe Connect meeting, the host has the opportunity to take advantage of 
Breakout rooms to break a larger group into several smaller groups without 
actually leaving the meeting room.

Features of the Breakout room:

• Hosts can create up to 5 separate Breakout rooms.

• Hosts can assign and move attendees to different rooms.

• Hosts can jump from room to room.

• Hosts can display pods from every Breakout room in the 
main meeting room or any other Breakout room.

• Hosts can return everyone to the main meeting room.

• Hosts can reset Breakout rooms.

• Hosts can clear all Breakout rooms.

• Hosts can begin and end Breakout sessions.

To launch Breakout rooms: 

• Breakout rooms are created from the attendee panel. In 
the upper left of the panel are three icons. The default 
view is the Attendee List.  Clicking the Breakout room 
icon presents you with a default of three breakout rooms. 
You can add another breakout room by clicking the Plus Sign 
icon.

Assigning attendees:

• By rolling a mouse cursor over an attendee’s name, hosts can move the 
attendee into breakout rooms or back to the main meeting room.

• With large groups, hosts may choose to use the Evenly Distribute icon, to the 
left of the Plus icon, to connect attendees to breakout rooms.

• The Breakout room inherits the layout and the content from the main meeting  
room at the time the breakout room is created.

Communicating in a Breakout room:

• 	If audio is VoIP, then the VoIP splits into separate VoIP rooms in each breakout room.

• If audio is a conference call, certain audio integration partners will allow for the call to split into separate 
conference calls for each breakout room and then back again to the main meeting room.

• Hosts can jump to different breakout rooms and back to the main meeting, assigning themselves to the room 
when they roll their mouse cursor over their names. 

Host start Breakout rooms

Hosts can automatically distribute all attendees 
evenly to all Breakout rooms

Hosts assign attendees to Breakout rooms individually



Communicating in a session:

Once you join a breakout session, communication is exclusively with other participants in that session. You can 
use chat, annotations, or communicate by phone or VoIP (depending on how you joined the main training 
session).

However, if you do need assistance from the main session presenter, just click the Ask for Help button and a 
prompt will be sent.

1. On the Breakout Session panel, click the Ask for Help button. A Help icon appears next to your name in the 
main session as well as a text alert.

2. 	Click Raise Hand on the Participant panel. A Raise Hand icon appears next to your name on the Participant 
panel in the Breakout session.

Sharing content in the main session:

Once back in the main session, the discussion can continue. If shared documents were saved on exiting the 
breakout session, then those documents can be shared in the main session.

1. Select Breakout > Share Breakout Session Content. The last presenter for each breakout session will be 
listed with the topic of his or her session.

2. 	Choose a presenter and click OK. The chosen presenter is sent a request to share breakout session content.

3. 	The breakout session presenter selects a content item and clicks OK. The content appears in the content 
viewer of the main training session.
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Communicating in a session:

• Hosts can send notification messages to all rooms by selecting Broadcast 
Message from the Attendee Pod Options menu.

• Attendees can send messages to hosts through a chat dialog box at the 
bottom of the Breakout room participants list.

• Breakout rooms work just like the main meeting room without additional 
layouts.

• Participants are promoted to presenters in the breakout rooms.

• Hosts can move attendees to different breakout rooms or back to the 
main meeting.

• Hosts can open Breakout room pods from other breakout rooms for 
participants to view only by selecting Breakout rooms from the Pods 
menu and then the specific room to view.

Sharing content in the main session:

Once back in the main session, the discussion can continue. If 
shared documents were present when the breakout session 
was closed by a host, then those documents can be shared in 
the main session.

1. Select Pods > Breakout Pods > your breakout room number 
and then either the chat window content or the share 
window content from the breakout room can be displayed.

2. Select the content you want share in the main meeting room.

To End a breakout session:

Click the End Breakouts button at the top of the attendee 
panel.

• From the attendees perspective, they are all back in the main 
meeting room. 

• Attendees remain assigned to their breakout rooms until moved, even if the breakout sessions have ended. 
To remove their Breakout room assignments, the host rolls a mouse cursor over their name in the Attendee 
List and selects Main Meeting, or the host can reassign the attendee to a different meeting room.

• Breakout rooms maintain their state until changed.

• Breakout rooms can be removed by selecting Remove All rooms from the Attendee Pod Options menu.
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Host can bring a Breakout room into 
the main conference

After Breakout rooms are closed, hosts can bring 
Breakout room Share pods or Chat pods into the 
main conference.
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6. �Additional 
features of  
Adobe Connect
Lesson overview

Topics covered in this lesson:
•  Connection properties
•  Sharing content for Adobe Flash technology
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Setting and viewing connection properties
Setting and viewing connection properties

Hosts have the ability to set meeting room connection and display properties that provide the best viewing 
opportunities for all attendees and that take attendee bandwidth connections into consideration.

Select Meeting > Preferences > room Bandwidth to set a bandwidth value that’s consistent with those 
participating in the session. For example, selecting LAN would be appropriate for an internal organization 
meeting where everyone is connected on the organization’s intranet. DSL/Cable is a good choice if it’s not 
clear what bandwidth attendees are using. A modem would be used if you know some attendees are 
connected through a dial-up system.

Select Video from the Preferences menu and you can increase video quality or reduce it depending upon 
bandwidth considerations.

Select Screen Share to optimize attendees experience when viewing presenter and host presentations of 
desktops and applications. Adobe Connect provides the flexibility to choose the appropriate frame rate and 
quality parameters to suit the content being shared. Higher frame rate and quality lead to an increased 
bandwidth requirement for attendees. Depending upon the type of content being shared and bandwidth 
considerations, you can choose appropriate values for the best experience. For sharing a slide show, a lower 
frame rate and high quality can be used, while presenting a demo where exact mouse movements need to be 
captured, a higher frame rate with a lower quality setting would be better.

A host or a participant can check the connection status by looking at the following room status indicators 
located in the upper right corner of the meeting room:

• Green = Good connectivity

• Green half bar = Weak signal strength

• Gray twirly icon = Network disconnect

Clicking the Connection Status icon will produce an on-screen notification indicating the exact connection 
parameters.

Attendees may also select Help > Troubleshooting. A connection test web page opens that will advise 
attendees about the bandwidth of their connection.
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Sharing content for Adobe Flash technology
Sharing Adobe Presenter content

Adobe Presenter is an add-in that works directly with Microsoft PowerPoint to turn ordinary slide 
presentations into multimedia self-running presentations in Flash SWF format. With Presenter, non-
technical subject matter experts can create meaningful learning content for delivery in Adobe Connect 
eLearning courses, web meetings, and webinars. 

The Presenter Add-in to Microsoft PowerPoint allows content developers to add narration to slides; add 
time narration to animated slide content; add video from webcams or other sources; and create 
interactive quizzes, tests, and surveys. Courses created in Presenter may be tracked in Adobe Connect’s 
Learning Content Management System, and they are also SCORM and AICC compliant for integration 
with most Learning Management Systems.

Sharing video for the Adobe Flash Player

Adobe Connect can display video for the Adobe Flash Player (FLV files) in a meeting, event, or training 
room. FLV is a video format that can be played back by the Adobe Flash Player.

Adobe Flash Player lets you easily put video on a web page in a format everyone can view. There are no 
additional plug-ins or software that are needed. 

Adobe Flash Player gives you the ability to:

• Build custom video players that match your site design

• Integrate the video with other Flash features like animation, text, and interactivity

To load FLV files:

1. Select an FLV file to share in the Share pod.

2. When the FLV is loaded, a video control bar appears for the host or presenter.

There is a FLV control bar. FLVs do not begin playing automatically.

If the FLV file has audio, it is broadcast to all participants.

FLV files always have synchronized navigation. You cannot disable it because there is no Share pod Sync 
button. 

Sharing content for Adobe Flash technology

Adobe Connect is a Flash technology powered environment. As result it handles SWF files seamlessly. To 
upload a SWF, treat it as any document stored on your hard drive that can be displayed in Adobe 
Connect. SWF files are imported by clicking Share My Screen in the middle of the Share pod and then 
selecting Share Document. The document may also be located on the Connect Library.

All the interactive features you’ve built into your SWF file are available to hosts and presenters. Movies 
for the Adobe Flash Player that were built using the Adobe Collaboration Builder Software Developer’s 
Kit allow all interactive Flash features to be independently available to each attendee in a meeting 
whether they are participants, presenters, or hosts.

Note: FLV files are loaded at 
different speeds for different 
computers.
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7. �What’s new in 
Adobe Connect 8 
Lesson overview

Topics covered in this lesson:
•  Easier to use
•  Better collaboration
•  Richer audio and video experiences
•  Improved access and extensibility
•  Increased security and enterprise support
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Easier to use

A primary focus of Adobe Connect 8 is usability. With a new simplified interface featuring enhanced layouts 
and better organized controls, accessibility functions, and one-click sharing, Adobe Connect is now more 
powerful and easier to use. New usability features include:

• Simplified user experience—Use Adobe Connect more intuitively. With the new user interface, you can 
easily discover all available functions and features through better organization and prominent display of the 
most important and frequently used controls and capabilities.

• Enhanced audio and video controls—Access audio and video controls centrally. Audio and video controls 
are prominently displayed and logically organized at the top of the meeting bar. All related capabilities are 
now centralized and easily accessible directly from each control.

• Unified attendee management—Access all participant management functions from the Attendee pod. Hosts 
can change participant roles using simple drag and drop and assign video, audio, or screen-sharing rights 
using mouse-over controls. Presenters can quickly get the vote count using the new status view and easily 
control breakout sessions using the new breakout view.

• Optimized screen use—Size your screen area for optimum viewing. The meeting interface rescales 
intelligently to provide optimum viewing experiences for any screen size or resolution. Presenters can now 
size their own version of the presenter-only area individually without impacting the view of other presenters.

• Improved accessibility—Navigate the Adobe Connect 8 interface completely via keyboard. Several hot keys 
are also supported for direct access to important functions and capabilities. Significant improvements in 
screen reader compatibility include JAWS and Win-Eyes support and accurate focus-location tracking by 
screen magnification software.
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Better collaboration

To collaborate effectively, dispersed teams need to be able to share ideas and communicate freely, as 
well as capture decisions and results. With Adobe Connect 8, collaboration capabilities are now more 
flexible and robust, enabling teams to drive better results. New collaboration features include:

• Advanced chat—Organize chat into separate tabs for public and private conversations and reduce 
errant chat messages. Participants can choose the color and text size of their chat messages. Hosts can 
control whether private chats are allowed in a meeting room.

• Rich Notes pod—Use rich formatting capabilities in the Notes pod, such as bold, italics, multiple colors, 
and bullets. The Notes pod also includes productivity and accessibility improvements like support for 
keyboard shortcuts. Hosts can save notes as an RTF file on their local drive and then email them to 
multiple participants directly from the Notes pod interface.

• Simplified Q&A pod—Easily manage questions between multiple presenters during meetings. 
Presenters now have their own view for managing and answering questions and can assign/reassign 
questions, see who is answering, and answer the question privately or publicly. Participants have a 
separate view to ask questions and see answers.

• Enhanced whiteboard—Collaborate more effectively with enhanced whiteboard tools. In addition to 
the standard shapes available, you can create custom shapes and add text to shapes with just a double-
click. The whiteboard can also be used in the overlay mode on top of a shared document to zoom and 
pan along with the document.
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Richer audio and video experiences

Adobe Connect 8 allows you to provide rich multimedia experiences to your participants with integrated audio 
and video conferencing. New features include:

• Two-way universal voice—Bridge the audio from virtually any audio conferencing provider into an Adobe 
Connect room and provide two-way communication between VoIP and telephone audio to deliver richer 
experiences for all participants.

• Video conferencing integration—Leverage existing investments in video conferencing solutions by 
integrating your video telephony devices supporting SIP/H.264 with the Adobe Connect platform (for 
on-premise deployments only). With this new feature, meeting hosts now have the option of bringing a live 
audio/video broadcast stream directly into an Adobe Connect meeting room.
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Improved access and extensibility

Busy professionals working on multiple projects with global teams need the ability to track down key people, 
instantly collaborate, and come up with responses quickly to meet project milestones. The optional Adobe 
Connect desktop client allows workers to do just that. Plus, new and enhanced plug-ins for Microsoft Outlook, 
Adobe Creative Suite® 5, and Microsoft Communication Server clients improve productivity, as does an 
enhanced collaboration SDK. Access and extensibility features include:

• New optional desktop client—Set up and manage meetings more easily with the new optional Adobe 
Connect Desktop Adobe AIR® client. Invite participants to meetings right from their desktop. You can also 
instantly search for archived Adobe Connect sessions and download and playback recordings offline.

• New and enhanced plug-ins—Use the Microsoft Outlook add-in to schedule meetings from your Microsoft 
Outlook contacts based on their Exchange Free/Busy time. Using Microsoft Office Communicator, you can see 
when contacts are online and available, then invite them to meet using their existing IM clients, or via the 
Adobe Connect desktop AIR client.

• Enhanced collaboration SDK—Write to more than 100 Adobe Connect APIs to customize the user interface, 
extend security features, or add virtually any functionality to Adobe Connect you desire. The new SDK also 
supports Flex, Adobe Flash technology, and Adobe ActionScript® 3 for richer, more dynamic interactions and 
even more engaging online collaboration.
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Increased security and enterprise support

Adobe Connect 8 is web conferencing for the enterprise. With strengthened security capabilities and improved 
support for virtualization and meeting resiliency, Adobe Connect is even more suited for enterprise 
deployments. New features include:

• Passcode-protected meeting rooms—Set and manage passcodes over some or all meeting rooms to better 
manage participants and control meeting access. Hosts can set and reset passcodes that participants are 
required to enter upon login, protecting sensitive information.

• Session management—Manage meeting session length for strengthened security and finer grained control 
of user sessions. Allow users to hold sessions for as long as necessary, while ensuring that idle sessions time 
out, reducing the risk of unwanted meeting access.

• Thin-client support—Provide rich-media collaboration in virtualized environments with support for Citrix 
XenApp 6. Improved delivery and performance of Adobe Connect 8 on Citrix XenApp 6 enables organizations 
to deploy rich, engaging web conferencing software throughout the enterprise while enjoying the lower TCO 
and increased agility of thin-client virtualization.

• Ubuntu 10 add-in—Experience full-featured meeting host capabilities with a new add-in for Ubuntu Linux® 
users. Now Linux users have the same capabilities Windows and Mac users do when hosting meetings.
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